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Printer Functions







1.1 Overview of printer functions 1

I
1 Printer Functions
1.1 Overview of printer functions

The printer driver is software that specifies how to use the printing functions of this machine from other ap-
plication software. When you install the printer driver on your computer, you can use a variety of this ma-
chine’s printing functions. Furthermore, the printer driver supports a wide range of connection methods and
provides flexibility in various environments.

It also supports direct printing, a printing method that does not use the printer driver, and printing from a USB
memory device.
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System requirements 1.2

1.2 System requirements
For Windows
Item Specifications
Operating system | The supported versions of the operating system vary depending on the installed
printer driver. For details, refer to page 2-6.
CPU Any processor of the same or higher specifications as recommended for your oper-
ating system
Memory Memory capacity as recommended for your operating system
The memory space must be enough for the OS and applications used.
Drive CD/DVD-ROM drive
For Mac OS
Item Specifications
Operating system Mac OS X (10.3.x, 10.4.x, 10.5.x, 10.6.x, 10.7.x, 10.8.x)
CPU PowerPC, Intel Processor
Memory Memory capacity as recommended for your operating system
Drive CD/DVD-ROM drive
@ Reference
For details on how to use the Linux printer driver, refer to Chapter 5 in [User's Guide Applied Functions].
1-4 d-Color MF 3300/3800



1.3 Cable connection ports of this machine 1

1.3 Cable connection ports of this machine

The printer cables are connected to each port on this machine.

No. Port Description

1 USB port Use a USB interface cable for USB connection.

Use a type A (4-pin, male) to type B (4-pin, male) USB cable. A USB
cable measuring three meters or less is recommended.

2 Ethernet port Use the LAN cable to connect this machine to the network. This ma-
(1000Base-T/100Base- | chine supports the 1000Base-T, 100Base-TX and 10Base-T proto-
TX/10Base-T) cols.

The TCP/IP (LPD/LPR, IPP), Web services and other protocols are
supported.
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2 Printing in the Windows

Environment







2.1 Preparation for printing (network connection) 2

i
2

2.1

211

2.1.2

Printing in the Windows Environment

Preparation for printing (network connection)

Overview
Before using this machine as a printer, you need to install the printer driver on your computer.

This section describes preparatory steps for printing from this machine using the installer that are supplied
with this machine.

Before installing the printer driver (for administrators)

Connecting this machine to the network
B Checking a LAN cable for connection
B Checking the network settings
- Check that an IP address is assigned to this machine.

4

Configuring the network printing environment
B When using the Normal Printing (at Port 9100)

- Make sure that the RAW port number has been set. (Usually, you can use the default settings.) Use
Normal Printing (Port 9100) unless otherwise specified.

B When using the Internet Printing (IPP)
= Check the IPP operating environment. (Usually, you can use the default settings.)
B When using the Secure Printing (IPPS)

- Set up the IPPS operating environment. Establish the communication with SSL encryption between
this machine and the computer.

4

Preparation finished

Checking a LAN cable for connection
Check that a LAN cable is connected to the LAN port of this machine.

For details on the cable connection port, refer to page 1-5.

Checking the network settings
Print out the Configuration Page, then check that an IP address is assigned to this machine.

To print out the Configuration Page, select [Utility] - [User Settings] - [Printer Settings] - [Print Reports] - [Con-
figuration Pagel].

@ Reference

If no IP address is displayed, you need to set up the network. For details, refer to [Quick Start Guide].

d-Color MF 3300/3800 2-3



Preparation for printing (network connection) 21

Configuring the network printing environment
Set up the operating environment to suit the printing method.

If the printing method is not specified before installation, Normal Printing (Port 9100) is selected for printing.
Use Normal Printing (Port 9100) unless otherwise specified.

For details on how to configure settings, refer to Chapter 1 in [User's Guide Applied Functions].

Printing method Description

Normal Printing (Port Make sure that the RAW port number has been set. (Usually, you can use the

9100) default settings.)

Internet Printing (IPP) Check the IPP operating environment. (Usually, you can use the default set-
tings.)

Secure Printing (IPPS) Set up the IPPS operating environment. Establish the communication with SSL
encryption between this machine and the computer.

Tips
° If you are using Windows Vista/7/8/Server 2008/Server 2008 R2/Server 2012, you cannot set up the
Secure Printing (IPPS) using the installer.

° If you are using Windows XP or Server 2003 in an IPv6 environment, you cannot set up the Secure Print-
ing using the installer.

° Internet Printing (IPP) is not supported in the IPv6 environment.

Allowing device information to be acquired from the printer driver
Disable the OpenAPI authentication function. (Usually, you can use the default settings.)

When you allow acquisition of device information from the printer driver, the printer driver automatically ob-
tains information such as what options are installed on this machine and whether or not authentication set-
tings have been configured.

For details on how to configure settings, refer to Chapter 1 in [User's Guide Applied Functions].
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21.3 Easy installation of the printer driver

Preparing the printer driver

B Preparing the printer driver CD/DVD-ROM
=> For the CD/DVD-ROM, contact the administrator of this machine.

B Checking the printer driver type
= Three printer drivers for different purposes are available. Select the printer driver that meets your

printing objectives.

B Checking the operating systems supported by the printer driver

- Check that your computer meets the operating environment requirements of the printer driver.

A4

Installing the printer driver to the computer
B Installing the printer driver using the installer

= Insert the printer driver CD/DVD-ROM into the drive, and install the software by following the on-
screen instructions.

B Performing a test print
= If necessary, make a test print, then check that it is acceptable.

A2

Preparation finished

Preparing CD/DVD-ROM disks for the printer driver

The following CD/DVD-ROMs are supplied with this machine: The printer driver is included on the Drivers &
Utilities CD/DVD-ROM.

CD/DVD-ROM Description

Drivers & Utilities CD/DVD-ROM Contains Windows printer driver (PCL/PS/XPS/FAX), Mac OS
printer driver, Linux printer driver, and TWAIN driver. It also
contains the download page of the utility software.

User's Guide CD/DVD-ROM Contains user's guides.

Checking the printer driver type

The following types of printer drivers are available. Select the printer driver that meets your printing objec-
tives.

Printer driver Page description lan- Description
guage

PCL driver PCL6 This is a standard driver for printing general office
originals.

Among the three drivers, this driver provides the
fastest printing speed.

PS driver PostScript 3 Emulation | This driver is effective for high-definition printing of
data created in PostScript-supporting application
software from Adobe or other vendors.

This driver is often used in graphics and light print-
ing applications where good color reproducibility is
important.

XPS driver XPS Developed after Windows Vista, this driver sup-
ports XML Paper Specification (XPS).

This driver has several advantages, including high-
quality reproduction of translucence.

d-Color MF 3300/3800 2-5



Preparation for printing (network connection) 21

Checking the operating systems supported by the printer driver

The following lists the printer drivers included on the CD/DVD-ROMs supplied with this machine and the sup-
ported operating systems.

Printer driver Supported operating systems
PCL driver Windows XP Home Edition (Service Pack 3 or later)
PS driver Windows XP Professional (Service Pack 3 or later)

Windows Server 2003, Standard Edition (Service Pack 2 or later)
Windows Server 2003, Enterprise Edition (Service Pack 2 or later)
Windows Server 2003 R2 Standard Edition

Windows Server 2003 R2 Enterprise Edition

Windows XP Professional x64 Edition (Service Pack 2 or later)
Windows Server 2003, Standard x64 Edition

Windows Server 2003, Enterprise x64 Edition

Windows Server 2003 R2, Standard x64 Edition

Windows Server 2003 R2, Enterprise x64 Edition

Windows Vista Business (Service Pack 2 or later)

Windows Vista Enterprise (Service Pack 2 or later)
Windows Vista Home Basic (Service Pack 2 or later)
Windows Vista Home Premium (Service Pack 2 or later)
Windows Vista Ultimate (Service Pack 2 or later) .
Windows Server 2008 Standard (Service Pack 2 or later)
Windows Server 2008 Enterprise (Service Pack 2 or later)
Windows Server 2008 R2 Standard

Windows Server 2008 R2 Enterprise

Windows 7 Home Basic

Windows 7 Home Premium*

Windows 7 Professional”

Windows 7 Enterprise*

Windows 7 Ultimate*

Windows 8 .

Windows 8 Pro .

Windows 8 Enterprise

Windows Server 2012 Datacenter

Windows Server 2012 Standard

XPS driver Windows Vista Business (Service Pack 2 or Iater)* .
Windows Vista Enterprise (Service Pack 2 or later)
Windows Vista Home Basic (Service Pack 2 or later)
Windows Vista Home Premium (Service Pack 2 or later)
Windows Vista Ultimate (Service Pack 2 or later) X
Windows Server 2008 Standard (Service Pack 2 or later)
Windows Server 2008 Enterprise (Service Pack 2 or later)
Windows Server 2008 R2 Standard

Windows Server 2008 R2 Enterprise

Windows 7 Home Basic

Windows 7 Home Premium*

Windows 7 Professional®

Windows 7 Enterprise®

Windows 7 Ultimate*

Windows 8 .

Windows 8 Pro X

Windows 8 Enterprise

Windows Server 2012 Datacenter

Windows Server 2012 Standard

i Supports 32-bit (x86)/64-bit (x64) environment.
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Installation procedure

Install the printer driver using the installer.

4
4

1

a b~ OD

Administrator privileges are required to perform this task.
Use the Drivers & Utilities CD/DVD-ROM.

Insert the printer driver CD/DVD-ROM into the CD/DVD-ROM drive of the computer.

- Make sure that the installer starts, then proceed to Step 2.

=> If the installer does not start, open the printer driver folder on the CD/DVD-ROM, double-click [Set-
up.exe], then go to Step 3.

= If the [User Account Control] window appears, click [Continue] or [Yes].
Click [Printer/FAX].

Read the license agreement, then click [AGREE].

Check the contents of the [Readme] window, then click [Next].

Select [Install printers/MFPs], then click [Next].

Connected printers are detected.

- For Windows Vista/7/8/Server 2008/Server 2008 R2/Server 2012, you can select [Preference for
IPv4] or [Preference for IPv6]. The address has the preference when detected in both IPv4 and IPv6.

Select this machine, then click [Next].

=> If this machine is not detected, restart it.

= You do not need to change the printing method from [Normal Printing] (Port 9100) unless otherwise
specified by the administrator.

= Asthe printing method, you can select [Normal Printing], [Internet Printing] (IPP), or [Secure Printing]
(IPPS).

- Among the connected printers, only the target model is automatically detected and displayed. If
multiple target models are displayed, check the IP addresses.

= If the connection to this machine cannot be recognized, it is not displayed in the list. In such a case,
select [Specify the Printer/MFP Except for the Above. (IP Address, Host Name...)], then manually
specify the IP address and host name of this machine.

Select the check box of the printer driver you want to install, then click [Next].

= For features of each printer driver, refer to page 2-5.
Check the components to be installed, then click [Install].

If necessary, change the printer name or print a test page, then click [Finish].

Installation of the printer driver is then completed.

Settings Description

[Review] Displays the installed components for checking.

[Rename Printer] Changes this machine name, if necessary.

[Property] Sets the optional operating environment of this machine. For details, refer
to page 2-8.

[Print Setting] Changes the default print settings of this machine, if necessary. For de-
tails, refer to page 2-8.

[Print Test page] If necessary, print a test page to check that printing process works cor-
rectly.

@ Reference

When you finish installing the printer driver, configure the default settings of the printer driver. For details, refer
to page 2-8.
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214

Initializing the printer driver

Configuring the optional environment of this machine

When you use this machine for the first time, check that information such as what options are installed on
this machine and whether or not authentication settings have been configured is correctly reflected to the
printer driver.

Display the [Properties] window of the printer driver.

= For information on how to display the [Properties] window, refer to page 2-53.

In the [Configure] tab, check the information such as what options are installed on this machine and

whether or not authentication settings have been configured.

= By default, [Auto] in [Acquire Settings...] is enabled. The information on this machine is automatically
obtained and reflected to [Device Option].

= When [Auto] in [Acquire Settings...] is disabled, clicking [Acquire Device Information], obtains and
reflects the information on this machine to [Device Option].

=> If you cannot establish communication with this machine, manually set this information in [Device
Option]. Select the item to change from the list, and set a value in [Setting].

Click [OK].

Change the default print settings

If necessary, you can change the default print settings of the printer driver.

Display the [Printing Preferences] window of the printer driver.

= For information on how to display the [Printing Preferences] window, refer to page 2-56.

Change the print settings, and click [OK].

The changed settings are applied when printing is performed from any application software.

@ Reference

The printer driver contains a function to save favorite settings. This is useful to register frequently used print
settings as favorite settings. For details, refer to page 2-14.

2-8
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Preparation for printing (USB connection) 2

2.2

2.21

2.2.2

Preparation for printing (USB connection)

Overview
Before using this machine as a printer, you need to install the printer driver on your computer.

This section describes preparatory steps for printing from this machine using the installer that are supplied
with this machine.

Easy installation of the printer driver

Preparing the printer driver

B Preparing the printer driver CD/DVD-ROM
=> For the CD/DVD-ROM, contact the administrator of this machine.

B Checking the printer driver type
= Three printer drivers for different purposes are available. Select the printer driver that meets your

printing objectives.

B Checking the operating systems supported by the printer driver

= Check that your computer meets the operating environment requirements of the printer driver.

A4

Installing the printer driver to the computer
B Configuring the installation settings on the computer

= If you are using Windows 7/8/Server 2008 R2/Server 2012, you need to change the computer set-
tings in advance.

B Installing the printer driver using the installer

-> Connect the USB printer cable, insert the print driver CD/DVD-ROM into the drive, and install the
software by following the on-screen instructions.

B Performing a test print
= If necessary, make a test print, then check that it is acceptable.

A2

Preparation finished

Preparing the printer driver CD/DVD-ROM

The following CD/DVD-ROMs are supplied with this machine: The printer driver is included on the Drivers &
Utilities CD/DVD-ROM.

CD/DVD-ROM Description

Drivers & Utilities CD/DVD-ROM Contains Windows printer driver (PCL/PS/XPS/FAX), Mac OS
printer driver, Linux printer driver, and TWAIN driver. It also
contains the download page of the utility software.

User's Guide CD/DVD-ROM Contains user's guides.
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Checking the printer driver type

The following types of printer drivers are available. Select the printer driver that meets your printing objec-

tives.

Printer driver

Page description lan-
guage

Description

PCL driver

PCL6 This is a standard driver for printing general office
originals.
Among the three drivers, this driver provides the

fastest printing speed.

PS driver

PostScript 3 Emulation | This driver is effective for high-definition printing of
data created in PostScript-supporting application
software from Adobe or other vendors.

This driver is often used in graphics and light print-
ing applications where good color reproducibility is

important.

XPS driver

XPS Developed after Windows Vista, this driver sup-
ports XML Paper Specification (XPS).

This driver has several advantages, including high-
quality reproduction of translucence.

Checking the operating systems supported by the printer driver

The following lists the printer drivers included on the CD/DVD-ROMs supplied with this machine and the sup-

ported operating systems.

Printer driver

Supported operating systems

PCL driver
PS driver

Windows XP Home Edition (Service Pack 3 or later)

Windows XP Professional (Service Pack 3 or later)

Windows Server 2003, Standard Edition (Service Pack 2 or later)
Windows Server 2003, Enterprise Edition (Service Pack 2 or later)
Windows Server 2003 R2 Standard Edition

Windows Server 2003 R2 Enterprise Edition

Windows XP Professional x64 Edition (Service Pack 2 or later)
Windows Server 2003, Standard x64 Edition

Windows Server 2003, Enterprise x64 Edition

Windows Server 2003 R2, Standard x64 Edition

Windows Server 2003 R2, Enterprise x64 Edition

Windows Vista Business (Service Pack 2 or later)

Windows Vista Enterprise (Service Pack 2 or later)
Windows Vista Home Basic (Service Pack 2 or later)
Windows Vista Home Premium (Service Pack 2 or later)
Windows Vista Ultimate (Service Pack 2 or later) .
Windows Server 2008 Standard (Service Pack 2 or later)
Windows Server 2008 Enterprise (Service Pack 2 or later)
Windows Server 2008 R2 Standard

Windows Server 2008 R2 Enterprise

Windows 7 Home Basic

Windows 7 Home Premium*

Windows 7 Professional®

Windows 7 Enterprise*

Windows 7 Ultimate*

Windows 8 .

Windows 8 Pro X

Windows 8 Enterprise

Windows Server 2012 Datacenter

Windows Server 2012 Standard
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Printer driver Supported operating systems

XPS driver Windows Vista Business (Service Pack 2 or Iater)* X
Windows Vista Enterprise (Service Pack 2 or later)
Windows Vista Home Basic (Service Pack 2 or later) |
Windows Vista Home Premium (Service Pack 2 or later)
Windows Vista Ultimate (Service Pack 2 or later) .
Windows Server 2008 Standard (Service Pack 2 or later)
Windows Server 2008 Enterprise (Service Pack 2 or later)
Windows Server 2008 R2 Standard

Windows Server 2008 R2 Enterprise

Windows 7 Home Basic

Windows 7 Home Premium*

Windows 7 Professional*

Windows 7 Enterprise*

Windows 7 Ultimate*

Windows 8 .

Windows 8 Pro .

Windows 8 Enterprise

Windows Server 2012 Datacenter

Windows Server 2012 Standard

. Supports 32-bit (x86)/64-bit (x64) environment.

Changing the installation settings (Windows 7/8/Server 2008 R2/Server 2012)
If you are using Windows 7/8/Server 2008 R2/Server 2012, change the computer settings before installing

the printer driver.
Open the [Control Panel] window.

= In Windows 8, right-click the Start window, then click [All apps] - [Control Panel].
= In Windows Server 2012, click [Control Panel] in the Start window.
= In Windows 7/Server 2008 R2, open the Start menu, then click [Control Panel].

Click [System and Security] - [System].

Click [Advanced system settings] on the menu in the left-hand pane.

The [System Properties] window appears.
In the [Hardware] tab, click [Device Installation Settings].

Select [No, let me choose what to do], select [Never install driver software from Windows Update.], then

click [Save Changes].

- After you have installed the printer driver, change the setting back to [Yes, do this automatically (rec-
ommended) ].

Click [OK] to close the [System Properties] window.
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Installation procedure

Install the printer driver using the installer.

4
4

1

o G~ W

\l

Administrator privileges are required to perform this task.
Use the Drivers & Utilities CD/DVD-ROM.

Connect a USB cable to the USB port of this machine.

= For details on the cable connection port, refer to page 1-5.
=> If a wizard window for adding new hardware opens, click [Cancell.

Insert the printer driver CD/DVD-ROM into the CD/DVD-ROM drive of the computer.

- Make sure that the installer starts, then go to Step 3.

= If the installer does not start, open the printer driver folder on the CD/DVD-ROM, double-click [Set-

up.exe], then go to Step 4.
= If the [User Account Control] window appears, click [Continue] or [Yes].

Click [Printer/FAX].
Read the license agreement, then click [AGREE].
Check the contents of the [Readme] window, then click [Next].

Select [Install printers/MFPs], then click [Next].

USB-connected printers are detected.
Select this machine, then click [Next].

Select the check box of the printer driver you want to install, then click [Next].

= For features of each printer driver, refer to page 2-5.

Check the components to be installed, then click [Install].

If necessary, change the printer name or print a test page, then click [Finish].
Installation of the printer driver is then completed.
Settings Description
[Review] Displays the installed components for checking.
[Rename Printer] Changes this machine name, if necessary.
[Property] Sets the optional operating environment of this machine. For details, refer
to page 2-8.
[Print Setting] Changes the default print settings of this machine, if necessary. For de-
tails, refer to page 2-8.
[Print Test page] If nﬁcessary, print a test page to check that printing process works cor-
rectly.

@ Reference

When you finish installing the printer driver, configure the default settings of the printer driver. For details, refer
to page 2-13.

2-12

d-Color MF 3300/3800



22 Preparation for printing (USB connection) 2

2.2.3 Initializing the printer driver

Configuring the optional environment of this machine

When you use this machine for the first time, configure the printer driver so that it contains information such
as what options are installed on this machine and whether or not authentication settings have been config-
ured.

Display the [Properties] window of the printer driver.

= For information on how to display the [Properties] window, refer to page 2-53.

In the [Configure] tab, configure the information such as what options are installed on this machine and

whether or not authentication settings have been configured.

= If you are using Windows Vista/7/8/Server 2008/Server 2008 R2/Server 2012, [Auto] under [Acquire
Settings...] is enabled by default. Thus, the information of this machine is automatically obtained and
applied for [Device Option].

= When [Auto] in [Acquire Settings...] is disabled, clicking [Acquire Device Information], obtains and
reflects the information on this machine to [Device Option].

= If you are using Windows XP/Server 2003, set the option manually using [Device Option]. Select the
item to change from the list, and set a value in [Setting].

Click [OK].

Change the default print settings

If necessary, you can change the default print settings of the printer driver.

Display the [Printing Preferences] window of the printer driver.

= For information on how to display the [Printing Preferences] window, refer to page 2-56.

Change the print settings, and click [OK].

The changed settings are applied when printing is performed from any application software.

@ Reference

The printer driver contains a function to save favorite settings. For details, refer to page 2-14.
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2.3 How to print
2.3.1 Printing operation flow
1 Open data of the original using the application software. From the [File] menu, select [Print].
2 n [Printer Name] (or [Select Printer]), make sure that the desired printer has been selected.
= The [Print] dialog box varies depending on the application software.
3 Specify the print range and the number of copies to print.
4 cClick [Properties] (or [Preferences]) to change the print settings of the printer driver, if necessary.
= The print settings you have changed here return to the default values when you exit the application
software. For information on how to change the default values of print settings, refer to page 2-8.
= The printer driver contains a function to easily recall frequently used print settings. For details, refer
to page 2-14.
5 Click [Print].
Printing is executed.
2.3.2 Easily recalling frequently used print settings
Registering the frequently used setting
You can register the current print settings as a favorite and recall it when executing printing.
When you register a frequently used combination of print settings as a favorite, you can easily apply all of
those settings just by selecting the combination from the Favorite Setting list, even if the combination is com-
plicated as it contains settings on multiple tabs.
The following explains the procedure of favorite print setting.
1 In the [Printing Preferences] window, set the print conditions you want to register as a favorite.
2 Click [Add..].
= When you edit an existing setting, select its name from the [Favorite Setting], then click [Edit] In the
Edit dialog box, you can select functions to be recalled with a favorite setting or import and export
a favorite setting.
£ My Tab|{Basic{ Layout [ Cover Mode [ Stamp/Compostion [ Gualty [ Gther |
Eavorte Setiing Urtitled -
He B -
Original Size: __Use( ‘Settings.
Sroe
| Eu
& s G @icoa
;::D[Tyne M @ Manually Print on 2nd Side
Printer Information Defadk
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23 How to print

3 Enter names of the favorites to be registered.

= Set an icon, a comment and call options for the favorite settings, if necessary.

Settings

Add Favrite sm_ ==

Name

ecol

lcon B -
Sharing

Comment

Description

[Name]

Enter names of the favorites to be registered.
Use names that can easily be identified.

[lcon]

Assign an icon to the favorite settings, if necessary.

[Sharing]

Select this check box to share the favorite settings with other users.

[Comment]

4 Click [OK].

Enter a comment to the favorite setting, if necessary.
The comment is displayed when you place the mouse cursor over the fa-

vorite in the Favorite Setting list.

The print settings are registered as a favorite. When starting printing, you can select the registered set-
ting from [Favorite Setting].
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Customizing the setting window

You can gather setting items from difference tabs and place them in [My Tab].

Registering frequently used setting items in [My Tab] allows you to change settings in one tab, without switch-

ing among multiple tabs.

This section describes how to edit [My Tab].

1 Click [My Tab] - [Edit My Tab..].

= You can also register a function in [My Tab] by selecting [to the LEFT] or [to the RIGHT] from the [My
Tab] menu that is displayed by right-clicking the function.

{=1 Printing Preferent

T8 Wiy Tab | Basic | Layout | Cover Mode | Stamp/Compostion | Gualty | Other |

avorte Setting Unttled

Q This teb allows you

(ST —

to amange setting tems as you like.

Select Color
© Auto Color

Job Retention

> Gray Scale =2l M
© Pottrait
E{l ) Lsndscaps Font Type
" Y - B
[ (} Onginal Size 2 ed
121 -
P d

From [Setting Item List], select the function you want to register in [My Tab], then click [to the LEFT] or

= Clicking [to the LEFT] places the selected function in the area to the left of [My Tab] and clicking [to
the RIGHT] places it in the area to the right of [My Tab].

= Anicon appears to the left of each function that is registered in [My Tab].

Setting fiem List

Basic [ Layout | Cover Mode | Stamp/Compostion | Qualty | Other |

&0 Onginal Oriertation
@ Original Size

aper Size
Zoom [25...400%]
Paper Tray
Paper Typs
@ Job Retertion
Track -
[¥ totmererr | [ tothe RIGHT
2 Uy Ta
EILEFT side C@AIGHT sde
Select Calor Job Retention A W
Orgnel Orientation it Type
Paper Size
opics (ORron
Regove
[ ok ][ Concel || Defak |[ Hep |

If necessary, move or delete the registered functions.

- To move a function, select the function and click [Up], [Down], or [Left/Right].
- To delete a function from [My Tab], select the function and click [Remove].

2

[to the RIGHT].
3
4 Click [OK].

Editing [My Tab] is then completed.
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24 Useful printing functions

24.1 Changing the paper size or type

Enlarging or reducing to the paper size ([Paper Size])

To make prints, enlarge or reduce the original with the zoom ratio that is automatically determined from the
original size and paper size.

If you select a paper size larger than the original size, the original is enlarged to the paper size. If you select

a paper size smaller than the original size, the original is reduced to the paper size.

In [Paper Size] of the [Basic] tab, select the size of paper for printing. The zoom ratio is automatically deter-
mined by the paper sizes selected in [Original Size] and [Paper Size].

1 Tips

(=1 Printing Preferent

|| [ £ My Tab | Basic | Layout | Caver Mode | Stamp/Compostion | Quaity | Other |

Favorte Seting Unttled -
Job Retertion
E‘ﬂ Pt -
8172401 -
Authenticstion/Accourt Track.
& Faper Size
L | Copies
1 | 11999
Zoom [25..400%]
o B o
© Manual
=8
Paper Tray
Be = 2l
</ EQ Manually Print on 2nd Side:
E Paper Type
8 s .
Priter [nfomation

This function is enabled when [Zoom] is set to [Auto].

Enlarging or reducing by the desired zoom ratio ([Zoom])

You can print the original image after it has been enlarged or reduced by the desired zoom ratio. The zoom
ratio can be specified between 25% and 400% (in increments of 1%).

In [Zoom] of the [Basic] tab, specify the zoom ratio.

/#0 Printing Preferent

|| [ £ MyTeb| Basic | Layout | Cover Mode | Stamp/Compostion | Quaity | Other |

Original Orientation Job Retention
© Portrait
) Landscape E‘ﬂ Pt M
31721 -
Authentication/Accourt Track.
& Paper Size
Same as Onginal Size - | Gepies
T 2 nosesy
Zoom 25..400%]
Orn ) mouse
© Manual
=% |
Peper Tray
D ) Auto ~ 3
</ @ Manually Print on 2nd Side:
F Paper Type
B Nosetirg .
Prrter [romation
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Printing on paper of a special size ([Original Size])

A special sized original is printed on custom sized paper loaded in the Manual Feed Tray.

1 In [Original Size] of the [Basic] tab, select [Custom Size].

= In [Paper Size], select [Same as Original Size].

2 Specify the width and length as desired, then click [OK].

Width Unit

BE 2] inch [363..850] ©mm
- ®inch
1100 = inch [5.83..12.00)
[ ok [ Concdd ][ Defak ][ Heb

@ Reference

Load the custom sized paper in the Manual Feed Tray. For details on how to load paper into the Manual
Feed Tray, refer to Chapter 6 in [User's Guide Introduction].

When you are using the PCL driver, you can pre-register a custom size in the [Settings] tab. For details in the
[Settings] tab, refer to page 2-55.

Specifying the paper type ([Paper Type])

In [Paper Type] of the [Basic] tab, select the type of paper for printing.

£ My Tab| Basic | Layout [ Cover Mode | Stamp/Compostion | Qualiy [ Other |
B 171 (et ) Eavorte Sefting Unttled -
3 1/2x11 B5x11m) Onginal Oriertation Job Retertion
Portrsit E Pt
Landscape =] P
8121 -
Authertication/Account Track.
& Paper Size
Same as Original S - Copies
1 =] 1..9%89)
Zoom [25..400%]
© Ao L wooae
Manual
=3
<‘ Paper Tray
D ; Auto - 3
o 30 ooty Pt on 20 sice
Paper Type ‘
-
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Specifying the paper tray ([Paper Tray])
In [Paper Tray] of the [Basic] tab, select the paper tray for printing.

Printing Preferences

£ My Tab| Basic | Layout [ Cover Mode | Stamp/Compostion | Qualky | Other |

Prvter Hornaion

PR .
Job Retention
Bge .
g1/ ~
Authentication/Account Track.
¥ Paper Sz
Same as Ongnal Size - | Dl
1 =] 119999
= @]@l [ Collste:
Baper Tray
I - ;
(B0 Moty Pt cn 20 ice
Paper Type
No setting -

1 Tips

If you select [Auto], the paper tray for the paper you have selected in [Paper Size] is automatically selected.

Printing on postcards

Print the original on the postcard loaded in the Manual Feed Tray or Tray 1.

1 Setas follows on the [Basic] tab.

= [Original Size]: Select [Postcard].

= [Paper Size]: Select [Same as Original Size].
= [Paper Tray]: Select [Manual Feed] or [Tray 1].

=) Printing Preferences

£ MyTab| Basic | Layout [ Cover Mode | Stamp/Composition | Gualty | ther |

FPosicard (100<148 mm) Fevorte Seting Untiled -
J-Postcard (100x 148 mm) Job Retention
E‘E Prnt -
Japanese Postcand -
Authentication/Accourt Track.
& Paper Size
‘Same a5 Original Size + | Cories
1 =) [1..9999]
Zoom [25.. 400%]
- s M .
© Manual
=8
Paper Tray
D (} WManual Feed -
[ Manually Prirt on 2nd Side
E Paper Type
B s .
s T e

2 Execute printing.

= For information on how to load postcards, refer to Chapter 6 in [User's Guide Introduction].

d-Color MF 3300/3800
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24.2 Printing multiple sets of copies
Specifying the number of copies ([Copies])
In [Copies] of the [Basic] tab, specify the number of copies you want to print.
[ £ My Tab | Basic | Layout | Cover Mode | Stamp/Compostion | Gualty [ Other |
2 i/ Bt Foreric Sty (Uned -
;E‘:l Prirt v
Original Size _—Use( Settings.
ras 7
Z:;zfnjsjm ] 2 1199991
© Ado ™ e % %@ [ Collste
=
D </ PMQT T @ Manually Prirt on 2nd Side
Towrs 2|
Pirter nformation Dotk
@ Reference
When you print a large number of copies, use of the Proof then Print function will prevent a large number of
misprints being created, reducing the amount of waste paper generated. For details, refer to page 2-42.
Printing on a set basis ([Collate])
When the [Collate] check box on the [Basic] tab is selected, copies are output separately in a set-by-set man-
ner, for example, "Pages 1, 2, 3, 4, and 5", "Pages 1, 2, 3, 4, and 5", and then "Pages 1, 2, 3, 4, and 5".
£ My Tab| Basic | Layout [ Cover Mode | Stamp/Compostion | Qualky | Other |
Favorie Sefting Uniited -
;E.:l Prirt -
Criginal Size __Use( Settings. .
& Paper Size .
Same as Original Size - —EL: s
e | Wl gow
D </ 7M° M EQ Manualy Prirt on 2nd Side
== .
Printer Information
Cancel Hslp
2-20
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24 Useful printing functions

243 Saving the number of printed sheets

Printing multiple pages on the same side of a single sheet ([Combination])

You can print multiple reduced size pages on the same side of a single sheet to reduce the number of pages

to be printed.

In [Combination] of the [Layout] tab, select "N in 1". For example, when you select [9 in 1], the size of every

set of nine pages is reduced and printed on the same side of one sheet.

Eavorte Setting

817211 B 5x1hin)

| £ My Tab | Basic | Layout | Cover Mode | Stamp/Compostion | Qualky [ Other |

2 [] Rotate 180

ERY

[7] Skip Blank Pages

[ image Shift

[] Brding Margin
Binding Margin Setfings

8 1/211 (8.5x11 ) e @pm Tyme
[mH] 2in1 - 1-Sided
[ Combnation Detais. ] Booklet Detais. .
Binding Pasition
[ Lefteind

Imege Shift Settings

Prete fomaton

Defau

it

If necessary, click [Combination Details...] to set the page layout order and whether or not to input border

lines between pages.

Combi

n
EESI -
Layout Order

Leftto-Right -
] Border

X Frame

([ ok [ Cocel | [ Defout | [ bep

Settings Description

[Layout Order] Select the page layout order.

[Border] Select this check box to draw border lines between pages. In addition, select

the type of border lines from [Frame] and [Line].

d-Color MF 3300/3800
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Copying on both sides of paper ([2-Sided])
By using both sides of paper for printing, you can halve paper consumption.

In [Print Type] of the [Layout] tab, select [2-Sided].

2 My Tab [ Basic [{Layout ¥ Cover Mode | Stamp/Compostion | Guaity | Other |

81/211 @ 5x11in)

7| [DRowtete0

=g

[T Skip Blark Pages

Fevorte Seiting Unttied .
[] Combination Print Type
] 2in1 25ded -
Combination Details. Booklet Details,

Binding Pesition

@ Left Bind -

[71 Binding Margin
Binding Margin Settings
[[limage shit

D ( Inage Shit Seftings...
7
Prrter information

Skipping blank pages ([Skip Blank Pages])

Skip blank pages contained in the original when printing the original. You can reduce the number of printed

sheets.

In the [Layout] tab, select the [Skip Blank Pages] check box.

1 Tips

£, My Tab | Basic | Layourt | Cover Mode | Stamp/Compostion | Quaity | Other |

——
[T Combination Print Type
(mm] 2in1 2:Sided -
Combination Details Booklet Details
Binding Position
D Left Bind v
[ Rotate 130 [7Iinding Merars
[ Skip Biark Pages Binding Margin Seftings...
E‘ﬂ [ image Shit
D ( Image Shift Seftings.
e
Printer frformation

For some originals, blank pages are also printed.
This function is only available for the Windows printer driver (PCL/XPS).

2-22
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Printing on the back side of printed sheet ([Manually Print on 2nd Side])
In the [Basic] tab, select the [Manually Print on 2nd Side] check box.

1 Tips

(= Printing Prefere:
il

| £ My Tab| Basic | Layout | Caver Mode | Stamp/Compostion | Guaity | Other |

=g
EIRY
P homion

Favrte Settng Unttied -
Jof Retertion
=S -
8121
Authertication/Account Track
& Paper Sizz
Same as Ongnal Size Copies
2 B n.oese
Zoom [25..400%]
© Ago = RS @l@l ] Collate
© Marual
[ izl P on 2nd Side:

Manual Feed.

Place the printed side of the paper face-donn

;

When specifying [Manually Print on 2nd Side] for printing, use the back side of the sheet printed on this ma-
chine. The printing result with this setting is excluded from assurance.

d-Color MF 3300/3800
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2.4.4 Adjusting the layout

Printing in a booklet format ([Booklet])

Sort pages of the original in booklet format to perform 2-sided printing in two-page spread. When the printed
sheets are collectively folded in two, they are arranged in the page order like a book.

In [Print Type] of the [Layout] tab, select [Booklet].

= Printing Prefere

£ My Tab | Basic | Layout | Caver Mode | Stamp/Composiion | Guaity | Other |
8 /211 (B5x11 ) Eaverte Seting it -
8 17511 (8511 m) @ Combination Print Type
(W] 2in1 55 Booklet -
Combination Details Booidet Details
Binding Postion
&y
[ LeftBind
7] Rotate 180 % Binding Margin
[T Skip Blark Pages Binding Margin Settings.
E{I [Flimage Shit
D ( Inage Shit Seftings...
7
The of a folded booidet half th -

If necessary, click [Booklet Details...], then specify the binding position and whether or not to insert a border
line between pages.

I 8 1/2x11 (8.5x11in) Binding Diregtion

8 /211 85x11m) EI Left Binding -

HE -

[c 3

[ ok ][ cancel |[ Defak | [ Hep

Settings Description
[Binding Direction] Select the binding position in booklet format.
[Border] Select this check box to draw border lines between pages.
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2.4 Useful printing functions 2

Adding a margin on pages ([Binding Margin])

You can add a binding margin to each page to bind the printed sheets.

1 In the [Layout] tab, select the [Binding Margin] check box.

= In [Binding Position] of the [Layout] tab, specify the margin position.

= Printing Preferen:
£, My Tab | Basic | Layout | Cover Mode | Stamp/Compostion | Quaity | Cther |
B 1/201 @it} n Uritled -
Pint Type
2:Sided -
Combination Detais Booklet Detals
Binding Postion
[ erans -
[7] Rotate 180 [#/inding Margi
[ Skip Biank Pages Binding Margin Settings.
[ mage Shit
D < Image Shit Seffings.
g
Printer Information

2 Click [Binding Margin Settings...].

3 Adjust the size of margin, then click [OK].

Binding Margin Settin
Shit Mode
® el SFif:

Front Side: Unit

0002 inch [0.00..1.96] ©mm
@ %aff dee @ inch
0.00 - inch (0.00...1.96]
Same valus for front and back sides
[0k [ conesl ][ Detar |[ hep
Settings Description
[Shift Mode] Select how the images are shifted for creating the margin.
[Front Side]/[Back Specify the size of the margin on the front side.
Side] When you print on both sides, specify the size of the margin on the back
side. When the [Same value for front and back sides] check box is select-
ed, a margin of the same size is created on both the front and back sides.

1 Tips

This function is available only for the Windows printer driver.
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Printing a poster-sized image ([Combination])

Enlarge an original image and divide it into multiple sheets to make prints. When you join the printed sheets

together, a large poster is created.

In [Combination] of the [Layout] tab, select "N x N". For example, when you select [2 x 2], one page of the
original image is enlarged, divided, and printed on four sheets.

2. My Tab | Basic | Layout | Cover Mode | Stamp/Compesiion | Quaity | ther |

81/211 @ 5x11in)

=g

a <

Favorte Settng Unttied -
Combination @ Pint Type
] 2x2 - 1-§ided
Combnation Detals. Booklet Detais
Binding Posiion
] tetans -

[] Botate 130
[T Skip Blark Pages

[71 Binding Margin
Binding Margin Settings
[[limage shit
Inzge Shift Settings...

Pt Fomation

Gores [t

If necessary, click [Combination Details...] to select whether or not to create overlap margins.

Combination

[ Overap width iine:

H -

0K | [ Coneel | [ Defur

] [ Heb

1 Tips

This function is available only for the PCL driver.

Rotating the image 180 degrees ([Rotate 180])

Print an image upside down. This function is available when printing on envelopes of which the loading di-

rection cannot be changed.

In the [Layout] tab, select the [Rotate 180] check box.

£ My Tab | Basic | Layout | Cover Mode | Stamp/Composttion | Qualky | Other |

P
[T Combination Print Type
(mm] 2in1 2Sded -
Combination Detals Booklet Details.
Birding Pastion
[AREEE .
(7 Betate 18% [] Binding Margin
[ Skip Biank Pages Binding Margin Settings. .
E‘:I [ mage Shf
D ( Image Shift Seftings.
e
oo
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2.4 Useful printing functions 2

Fine-tuning the print position ([Image Shift])

Fine-tune the print position of an image upward, downward, rightward, and leftward with respect to the pa-
per. When performing 2-sided printing, you can also fine-tune the print position of an image on the back side.

This function is available when a fine adjustment is required to slightly adjust the print position or change the
print position between the front and back sides.

1 In the [Layout] tab, select the [Image Shift] check box.

(= Printing Prefere:

| £ My Tab [ Besic | Lavout | Cover Mode [ Stamp/Compostion [ Gualty [ Gther |

avorte Seting Untitled -
[C]Combination Print Type
(mm] 2in 1 2Sided -
Combination Details... Booidet Details.
Binding Psttion
[ wetang -
[7] Rotate 180
[71 ki Blank Pages
Imege Shit Setings.

2 Click [Image Shift Settings...].

3 Adjust the upward/downward and rightward/leftward shift distances, and click [OK].

(l (Il
Front Side [2.93..+3.93nch] Back Side [393..+3 9inch]
Horizontl [Left-, Fight:+] Honzonta [Left-. Right:#]
W 2 inch 000 2 inch
Vertcal [Bottor:~ Top:] Vertcal [Bottom:, Top:]
000 [ inch 000 2] inch
Unit
©rmm
@ inch
[ ok ][ concel |[ Defak ][ ke

1 Tips

This function is available only for the PCL driver.
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2.4.5

Adding a text or image to the original

Adding a water mark ([Watermark])
Print a text such as "NO REPRODUCTION" and "INTERNAL USE" on the center of all pages in a tint color.

By printing a watermark, you can specify the handling policy of copied originals.

In the [Stamp/Composition] tab, select the [Watermark] check box. In addition, select the watermark you

want to print.

1 Tips

£ My Tab | Basic | Layout | Cover Mode | Stamp/Compostion | quaity | Other |

Eavorte Setting Untitled

=5

B¢

Pt Ffomaton

£2 NO REPRODUCTION
£& TOP SECRET

£2 INTERNAL USE

£2 IMPORTANT

Defauk

This function is available only for the Windows printer driver.
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Registering or editing a watermark

This machine has several factory-set watermarks. However, you can register new watermarks or edit existing

watermarks, if necessary.

1 In the [Stamp/Composition] tab, select the [Watermark] check box, and click [Edit].

2 Click [Add] and register the watermark data.

= To edit a registered watermark, select the watermark from the [Current Watermark] list, and edit the

data.

= To delete a registered watermark, select the watermark from the [Current Watermark] list, and click

[Delete].

Settings

e N
@ Cumert Watermark
~100%
z URGENT Watemnark Name
URGENT
& WITHDRAW
& NO REPRODUCTION Watemark Text
< & TOP SECRET URGENT
& INTERNAL USE §
& IMPORTANT 35 Delte
00% e
3 Fort Name Size
bE
: % [ Foapr.cu
-100% +100%
Posiion|-100...+100] Styie o
x 0 Euyo [ Regular - MNone -
— Text Golor
Angi — Fed ~ [ Transgarent
Dge = [ 1st Page Only
~ | Degrees|-180...+180] o e
Sharng
[ok [ cancel | [ pefar |[ koo

[Watermark Name]

Enter the name to be displayed in the watermark list (using up to 30 char-
acters).

[Watermark Text] Enter the text to be displayed as a watermark (using up to 30 characters).

[Up)/[Down] Click these buttons to reorder items in the list. You can move frequently
used watermarks to upper positions.

[Position] Specify the print position for the watermark.

e [XI/[Y]: Adjust the horizontal and vertical positions of the watermark.
The values change as you move the slide bar.

e [Center]: Click this button to reset the watermark position to the center.

e [Angle]: Adjust the angle of the watermark.

[Font Name]

Select the font for the watermark.

[Size] Specify the font size for the watermark.

[Style] Select the font style for the watermark.

[Frame] Select the frame for the watermark.

[Text Color] Select the color of the watermark.

[Transparent] Select this check box to print the watermark in a translucent tone.

When this check box is cleared, the printed watermark obscures the back-
ground.

[1st Page Only]

Select this check box to print the watermark only on the first page of the
original.

[Repeat] Select this check box to repeatedly print the watermark on each page.
[Sharing] Select this check box to share the watermark with other users.
3 Click [OK].

d-Color MF 3300/3800
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Composing an overlay image ([Print in Overlay])

You can recall an overlay image registered on the computer to print it on the original as a composite image.
For details on how to register an overlay image on your computer, refer to page 2-31.

In the [Stamp/Composition] tab, select the [Print in Overlay] check box, then select the overlay image to be
composed on the original from the list.

(=) Printing Preferences

£ Ny Tab | Basic | Layout | Cover Mode | Stamp/Compostion | Guaity | Other |
Eavorte Setiing Urtitled -

] Watemark Create Overtay File

. W

Ao
WITHDRAW

£k NO REPRODUCTION

& TOP SECRET

& INTERNAL USE

& IMPORTANT

E‘S [T Copy Protect
ERV

If necessary, click [Edit...] to add or delete overlay images. Alternatively, change the method of composing

an overlay image.

When using the PCL/XPS driver:

Settings

Description

[Select Overlay File]

Add or delete an overlay image.

[Browse Files...]

Add an overlay image to the list.

[Delete]

Delete the selected overlay image from the list.

[File Information]

Displays information on the selected overlay image.

[Overlay Print Setting]

Change the method to compose an overlay image, if necessary.

[Pages]

Select the range of pages to compose an overlay image on.

[Overwrite]

When using the PS driver:

Settings

Select whether or not to overwrite an overlay image on the front side of the
original or to compose an overlay image on the back side of the original.

Description

[Select Overlay File]

Add or delete an overlay image.

[Manage Form
File...]

Manage an overlay image.

[Delete]

Delete the selected overlay image from the list.

[Download Manag-
er...]

Download an overlay image to the printer.
This option is available when the Download Manager is installed on this ma-
chine.

[Overlay Print Setting]

Change the method to compose an overlay image, if necessary.

‘ [Pages]

1 Tips

Select the range of pages to compose an overlay image on.

° This function is available only for the Windows printer driver.
. When the PS driver is used, you need to download a target overlay image to this machine in advance.

2-30
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Creating an overlay image on the computer

In the [Stamp/Composition] tab, select the [Create Overlay File] check box, then print data to be registered
as an overlay image to create an overlay file on the computer.

1

Create an original to be registered in an overlay image using application software.

2 Inthe [Stamp/Composition] tab, select the [Create Overlay File] check box.

= Printing Preferen:

I £ My Tab | Basic [ Layout [ Cover Mode | Stamp/Compostion | qualty [ Gther |

B /211 (511 im) Fovorte Setne Urted e

8 1/2x11 (8 5x11in)

[C] Watemmark. [¥]¢reate Overlay Fiict

3] Pt in Overay

& CIRCULAR
WITHDRAW

& NO REPRODUCTION

& TOP SECRET

& INTERNAL USE

£ IMPORTANT

Edi... Edit.

[T Capy Protect
@ < Edt...
7

3  Inthe application software, execute printing.
The [Create Overlay File] window appears.
4 Enter the file name to save the file.

The overlay file is saved on the computer. The saved overlay file is displayed on the [Stamp/Composi-
tion] tab, and it can be used for overlay printing.

1 Tips

This function is only available for the Windows printer driver (PCL/XPS).

d-Color MF 3300/3800 2-31



Useful printing functions 24

2.4.6

Deterring unauthorized copying

Printing a concealed security watermark ([Copy Protect])

Print a text such as "Copy" or "INTERNAL USE" in the background pattern as concealed text. This function
is called the Copy Protect function.

When a copy-protected original is copied, the concealed security watermark appears on the entire page,
thereby indicating that it is an unauthorized copy.

In the [Stamp/Composition] tab, select the [Copy Protect] check box.

If necessary, click [Edit...] to specify the text to be printed and the format of the text. For detalils, refer to
page 2-32.

12 My Teb [ Basic | Layout | Cover Mode | Stamp/Composiion | Quality | Other |
Favarte Sefing Unttied -
7] Watermark. [ Create Overlay Fie
| | Ceatin Ovedsy
& oncln [ ——
WITHDRAW
& NO REPRODUCTION
& TOP SECRET
& INTERNAL USE
& MPORTANT
[Egpy Protect
0%

1 Tips

This function is available only for the Windows printer driver (PCL).

Configuring the print settings for Copy Protect

When printing a copy protect pattern on sheets, you can set the text to be printed and the format of the text,
if necessary.

In the [Stamp/Composition] tab, select the [Copy Protect] check box, then click [Edit...].

Settings Description

[Pattern] Select whether or not the text pattern is to be embossed or outlined when the
original is subjected to unauthorized copying.

[Pattern Overwrite] Select whether or not to compose a copy protect pattern on the front or back
side of the original.

[Background Pattern] Select the copy protect pattern from the background patterns registered on
this machine.

[Text/Background Select the color of the copy protect pattern.

Color]

[Characters] Select the text to be printed.
Selecting [Custom] can specify any text.

[Font Name] Select the font of the text to be printed.

[Text Size] Select the size of the text to be printed.

2-32
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24.7

Inserting paper into the original

Inserting a front or back cover ([Front Cover] / [Back Cover])

Insert a cover sheet different from text sheets into the head and end of the original.

You can select a sheet that is different from text sheets (colored paper or thick paper) as a front cover, and
collectively print the front cover with text pages.

1 In [Paper Tray] of the [Basic] tab, select the paper tray for printing text pages.

2 Inthe [Cover Mode] tab, select the [Front Cover] or [Back Cover] check box.

=> If necessary, you can select whether or not to print the original on the inserted sheets or to leave

them blank. When the PS driver is used, you cannot print an original on the inserted sheets.

= In[Front Cover Tray] or [Back Cover Tray], select the paper tray for the paper to be used as the front
cover or the back cover.

. My Tab | Basic | Layout | Cover Mode | Stamp/Composton | Quaity | other |

Favorte Seting Unttled -
Fromt Cover [ Separator Page
+1) sk B 1) Hoader (Each Job)
Front Cover Tray
Ato - Ato
[#ifack Coved
[ Bank -
Back Cover Tray
Auto -
=5
W Bl
Frnter nfomation ===

d-Color MF 3300/3800
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2.4.8

Inserting a separator page ([Separator Page])

You can insert a sheet that is different from text sheets as a separator page on a job or copy basis.

1 In [Paper Tray] of the [Basic] tab, select the paper tray for printing text pages.

2 Inthe [Cover Mode] tab, select the [Separator Page] check box, then specify the position to insert a

separator page.

= In [Separator Page Tray], select a paper tray to load sheets to be used as separator pages.

= Printing Prefere

| £ My Tab | Basic [ Layout | Cover Mode | Stamp/Composition | Gualy | Gther |

B1/211 @511 in) vt Sefing Urtted -
8 2xil @x11in) [ Front Cover [#)Separstor Page
@ Blank % Header (Each Job) =
Front Cover Tray Separator Page Tray
Auto Auto -
7] Back Cover
QE Blank
Back Cover Tray
Auto
P promaion

Specifying the color and image quality

Selecting printing colors ([Select Color])

In [Select Color] of the [Quality] tab, select printing colors from Auto Color or Gray Scale.

(= Printing Prefere:

| £ My Tab | Basic | Layout | Caver ode | Stamp/Compostion || Gualty | Other |

[
=

=g
ERY

Pt Fomation

Favorte Seiting & Defauk Seting v | Add.
Select Color Resolution
® Auto Color 6000l -
© Gray Seale
o Pattem
Quality Adjustment Coarse v
Image Compression
Maximum Compression -
Color Settings 7] Glossy Mode
Photo
Presentation
Torer S
Frosent [E] Toner Save
Disable Edge Strength
Midde -
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Specifying the printing resolution ([Resolution])

In [Resolution] of the [Quality] tab, select the printing resolution.

I
=

Favorts Sefting & Defauk Seting v | Add,

Select Color
@ Auto Color
© Gray Scale

Qualty Adjustment..

Color Setfings

Photo

=5

B

Pt Ffomaton

Presentation
Custom

Disable

Besolution

600doi -
Pattem

Coarse -

Image Compression

Maamum Compression -
[C1Glossy Mode
[FTorer Save
Edge Strength
Midde -

Default

1 Tips

This function is available only for the PCL/PS driver.

Fine-tuning the image quality according to the original ([Quality Adjustment])

You can fine-tune the color image quality according to the original. For example, you can increase the vivid-

ness or reduce the color difference.

1 In the [Quiality] tab, click [Quality Adjustment].

I £ My Tab [ Besic [ Layout [ Cover Mode [ Stamp/Compostion |{ Guly || other |

=

Favorte Setting R Defaut Settng  + | Add.

Select Color
@ Auto Color
©) Gray Scale

Resolution
600dpi
Pattem

Qualty Adustment Coarse

Image Compression
Maximum Compression

[] Glossy Mode
E»ﬂ [T Toner Save
— Edge Strength
D (2 Middle -
Printer Information Defaut

2 Adjust the brightness and contrast to fit the original.

- When the PS/XPS driver is used, you can adjust only the brightness.

3 Click [OK].
1 Tips

Quality Adjustment

-15 +15

0K

] [ Concel | [ Defait | [ Hep

This function is available only for the Windows printer driver.

d-Color MF 3300/3800
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Selecting the optimum

You can select the optimum setti
optimum image quality level.

color representation for the original ([Color Settings])

ngs for an original such as photos or presentation materials to print it at the

In [Color Settings] of the [Quality] tab, select the optimum color setting mode to fit the original.

(= Printing

£ My Tab | Basic [ Layout [ Cover Mode [ Stamp/Compostion |{ Guliy || Other |

Eavorte Sefting £ Defaukt Seting v | Add_

Select Color FResolution
® Auto Color €00cki
©) Gray Scale

Qualty Adjustment. Coarse

g
E

=7
g8
)
5

o @
éa
H

g: [ Toner Save
— . Edge Strength
D (f Midde -
[ Pmstn. ]

If necessary, you can specify the
original in detail.

color representation method for each object (image, text, or graphics) in an

1 In [Color Settings], select [Custom], then click [Details...].

2 Specify RGB colors and output profile for printing on an image, text, or graphics category basis.

Settings Description

[Image] Configure a color setting for each image, text, or graphics category.
[Text] ¢ [RGB Source]: Specify the color space of the input RGB for the printer.
[Graphics] ¢ [RGB Intent]: Specify the property of color conversion from the input

RGB to DeviceCMYK that is processed by the printer.

e [RGB Gray Treatment]: Specify the method to make prints in black or
gray for the printer.

¢ [Destination Profile]: Specify the output profile for the printer (PS/XPS
only).
[Halftone]: Specify the screen property for the printer.
[Edge Enhancement]: Specify whether or not to enhance the edge
part.

[Simulation] (PS only)

3 Click [OK].

Tips

Configure the simulation settings.

e [Simulation Profile]: Select the simulation profile of the input CMYK for
this machine.

e [Match Paper Color]: Select whether or not to suit the background of
paper for printing when carrying out a simulation.

e [CMYK Gray Treatment]: Specify the printing method of plate K in the
CMYK input data for simulation.

When you are using the PS driver, the following functions are available in the window shown in Step 2.

° [Download Manager...]: Starts Download Manager to download a profile, font data, or overlay file to

this machine.

° [Manage Profile...]: Adds or deletes profiles.
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24 Useful printing functions

Specifying the density of a graphic pattern ([Pattern])
In [Pattern] of the [Quality] tab, select the density of a graphic pattern.

I
=

Eavorite Setting

& Defauk Seting v | Add,

=5
B

Prver Homann

Select Color
® Auto Color
© Gray Scale

Besolution
600
Pattem

Qualty Adjustment.. Coarss

Color Setfings

Photo
Presentation
Custom

Disable

Image Compression
Mazimum Compression

[C1Glossy Mode
[FTorer Save
Edge Strength
Midde -

Default

1 Tips

This function is only available for the Windows printer driver (PCL/XPS).

Specifying the compression ratio of a graphic image ([Image Compression])

In [Image Compression] in the [Quality] tab, select whether or not the quality or printing speed is preferred
when the image data contained in the original is compressed.

/#0 Printing Preferent

|| [ £ My Tab | Basic | Layout | Cover Mode | Stamp/Compostion |/ Guaity | Other |

[
=

=g
EIRY
P homion

Favorte Setting 2 Defauk Seting  » | Add.

Select Color Resolution
© Ao Color §00cp1 .
©) Gray Scale
ey Pattem
Qualty Adjustment Coarse v
Image Compression
Maimum Compression -
Color Settings []Glossy Mode
Photo
Presentation
Toner S:
Frosent [E] Toner Save
Disable Edge Strength
Vidde -

1 Tips

) This function is available only for the Windows printer driver (PCL).

° This function can be specified when [Auto Color] is selected in [Select Color].

d-Color MF 3300/3800

2-37



Useful printing functions 24

Making the image glossy ([Glossy Mode])

Images are printed with a glossy finish.

In the [Quality] tab, select the [Glossy Mode] check box.

. My Tab | Basic | Layout | Cover Mode | Stamp/Compostion | Quaity |ther

(= Printing Prefere:
il

En
ERe
Prver Homaton

Favorts Setting Untied -
Select Color Besaluton
® Auto Color 600d0i -
© Gray Scale
S Eattem
Coarse -

Qualty Adjustment..

Color Setfings

Futo
Photo
Presentation
Custom
Disable

Image Compression

Maamum Compression -
[#1Giossy Mode!
[FTorer Save
Edge Strengih

Middie v

u) Details.

Font Settings

Saving the toner consumption ([Toner Save])

Selecting the [Toner Save] check box in the [Quality] tab adjusts the printing density in order to reduce the

amount of toner consumed.

£ My Tab | Basic [ Layout [ Cover Mode [ Stamp/Compostion |{ Guliy || Other |

(=) Printing Prefere:
il

En
ERe
Prver Homaton

Eavorte Sefting Unttled -
Select Color Besolution
® Ao Color 0001 .
© Gray Scale
== Pattem
Coarse -

Qualty Adiustment.

Color Settings
Futo
Photo
Presentation
Custom

Disable

Image Compression
Masdmum Compression -

[C]Glossy Mode

Toner Save
Edge Sirengih

Viddie -

u) Details.

Font Settings

Sharpening the border between texts ([Edge Strength])

Sharpen the edges of images such as text in the table and graphics to improve legibility.

In the [Quiality] tab, select the [Edge Strength] check box, then select the emphasis level.

(= Printing Prefere:
il

En
ERY

Prete fomaton

Favorts Sefting & Defauk Seting v | Add,
Select Color Resolution
® Auto Color 600doi -
© Gray Scale
S Pattem
Coarse -

Qualty Adiustment.

Color Settings
Futo
Photo
Presentation
Custom

Disable

Image Compression

Maimum Compression v
[FGlossy Mode
[[]Toner Save
Edge Strength

Midde v

u) Details.

Font Settings
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Specifying the font processing method ([Font Settings])

Specify how the fonts are processed for printing.

1 In the [Quiality] tab, click [Font Settings].
£ My Tab | Basic [ Layout [ Cover Mode | Stamp/Composition |{ Gualiy || other | |
Favorte Sefing 2 Default Seting | Add.
o -
Color Settings [7] Glossy Mode
Auto
Photo
E’S zu"’gzza“w [ Toner Save
Disable Edge Strength
D </ Middle -
Printer Information [ o]
He
2 Change how the fonts are processed for printing.
Dewnload Fort Format I
E— -
Use Prirter Fonts
e Fortt rvln Use -
Amisnne Do Mot Use ]|
e ——— :
TrueType Fort Prirter Fortt to Use
oo
[0k [ coneal ][ Detar |[ e
Settings Description
[Download Font For- Select a type of font to be downloaded from the computer to this machine.
mat]
[Use Printer Fonts] Select this check box to replace TrueType fonts with printer fonts during
printing. Use of printer fonts increases the printing speed.
In normal printing operations, we recommend that you select this check
box.
[TrueType Font Sub- Set this table when you want to specify the printer fonts that replace Tru-
stitution Table] (PCL eType fonts.
only) From the list, select the TrueType font, then in [Printer Font to Use], select
the printer font with which you want to replace the TrueType font.
3 Click [OK].
1 Tips
. If characters are garbled in an environment where the PCL driver is used, we recommend that you se-
lect [Bitmap] in [Download Font Format] and clear the [Use Printer Fonts] check box.
[}

This function is available only for the Windows printer driver (PCL/PS).
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2.4.9

Printing Microsoft Excel/PowerPoint data

Printing multiple Excel sheets at one time

When multiple Microsoft Excel sheets with different print settings are printed at one time, this function pre-

vents the sheets from being printed separately.

In the [Other] tab, check the [Excel Job Control] box.

1 Tips

En

Excel Job Control
Remove Whie Background

Thin Line Suppot

0 <
Priter Information Defat
lic,

This function is only available for the Windows printer driver. However, this function may not be available de-
pending on a specific environment or application software.

Composing and printing an image correctly in PowerPoint

The process executed when an overlay image is printed on a PowerPoint original where a white background
is optimized. This function prevents the overlay image from being overwritten by the white background of the

PowerPoint original.

In the [Other] tab, select the [Remove White Background] check box.

1 Tips

|| [ £ My Tob [ Basic [ Layout [ Cover Mode [ Stamp/Composiion | Guaity |{Cther |

8 /211 @511 in)
8 1211 8511 m)

Eavorte Setting

% Defauk Setting v | Add_

En

Excel Job Control
Remove White Background

Thin Line Support

A ¢
Priter Information Defat
=

This function is only available for the Windows printer driver (PCL/XPS). However, this function may not be
available depending on a specific environment or application software.
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Preventing failure in printing thin lines ([Thin Line Support])
You can prevent thin lines from disappearing in reduced-size printing.

In the [Other] tab, select the [Thin Line Support] check box.

(=) Printing Prefere:
il

| £ My Tab | Basic | Layout [ Cover Mode | Stamp/Composttion | Qualty |{Cther |
Favorte Seiting 2 Defauk Seting  » | Add.

Excel Job Cortrol
Remove White Background

Thin Line Support

&

Bl
Check Driver Version
e

beo

1 Tips

° This is effective for thin lines such as table borders created in Excel, but not for thin lines used in illus-
trations.

° This function is only available for the Windows printer driver (PCL).
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2.5 Printing options
2.5.1 Making a trial printing for only one copy ([Proof then Print])

Proof then Print

Proof then Print is a function that makes prints by only one copy and holds the remaining copies when print-
ing multiple copies.

Because you can check the print result before starting to print the remaining copies from the Control Panel,
this function is useful for preventing printing of a large number of misprints.

How to print from the computer

1 In [Job Retention] of the [Basic] tab, select [Proof then Print].

Layout | Cover Mode | Siamp/Composiion | Gualty | Other |

Eavorte Seting & Defout Setfng | Add.
Oniginal Oriertation Job Retention

B rm

=l

B swore ob

Bl pot and Hold

%_‘3‘»”3 Secured Job

ize v
o 2
© Ado = =
© Manual - Proof then Print
=3 =]

=]
FPaper Tray %J ID&Frint

£ MyTab| Bas

ERCH :
</ @ Manually Print on 2nd Side
Papet Typ:
No setting v
Printer Information Defaut

2 Specify the number of copies, then execute printing.

Only one copy is printed. Continue to "Operations on this machine".
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Operations on this machine

1 Tap [Document Print/Delete].

Select function.

Job List Counter

Cor Q Scan To @ Scan To @
24 E-mail Folder

Document &
Print / Delete

2 Tap [Documents to Print].

Select desired function.

F

Utility

b &
Documents to Print ID & Print E"I“e"“"
lemory
Scanned
Documents

3 Select the desired user, then tap [Open].

4 Selecta job to print, then tap [Print].
= To delete a job, tap [Delete].

5 necessary, change the number of copies, then tap [OK].

d-Color MF 3300/3800
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2.5.2

Printing highly confidential documents ([Secured Job])

Secured Job

Secured Job is a function that saves print data with a password on the HDD of this machine. Because the
data is not printed straight away, this function prevents printed materials from going missing or being left un-

attended.

To print data from the HDD, you need to enter the password; this function is particularly suitable for safely
printing highly confidential documents.

How to print from the computer

1 In [Job Retention] of the [Basic] tab, select [Secured Job].

B 1211 (8 511 in)

£ My Tab| Basic | Layou | Gover Mods | Stamp/Compostion | Quaity | other |
Favorte Setting 8 Defout Seting = | Add,
Orientation Job Retention
E’:] Print
Ongal Size =
817201 M E’a Store Job
¥ Paper Size =
Same os Crgnal Size < Egentente
Zoom [25...400%] % Secured Job
® Ago " %
© Manual —C E"Q Proof then Print
Baper Tray E’?J 1D&Print
Ao e
(5 T Mansaly Pt on 200 5ide
Paper Type
No setting -
Printer Information Defouk

2 Enterthe password, then click [OK].

3 Execute printing.

User Settings

User Name: |

Job Name
@ Auto

Custom

Fassword
| 4-ohars

Hidg Password

Q Enter the password usedforthe “Secured Job." .«

[ok ][ concel ][ Defmr ][ hep

Print data is saved on the HDD of this machine. Continue to "Operations on this machine".
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Operations on this machine

To print the saved data, you need to enter the password specified in the printer driver.

1 Tap [Document Print/Delete].

Select function.

Job List Counter

Cor Q Scan To @ Scan To @ Fax
H E-mail Folder

¥
Document & Utilit -
Print / Delete Y

2 Tap [Documents to Print].

Select desired function.

s &

Documents to Print ID & Print

%

Scanned
Documents

External
Memory

3 Select the desired user, then tap [Open].

4 Selecta job to print, then tap [Print].

= To delete a job, tap [Delete].
5  Enterthe password specified when printing data from the computer.

6 i necessary, change the number of copies, then tap [OK].

d-Color MF 3300/3800
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2.5.3

Saving an original on the HDD of this machine ([Store Job] / [Print and Hold])

Store Job

Store Job is a function that saves print data on the HDD of this machine. Using the Print and Hold function,
you can print data while simultaneously saving it on the HDD.

How to print from the computer

1 In [Job Retention] of the [Basic] tab, select [Store Job].

= To print data while simultaneously saving it on the HDD, select [Print and Hold].

2  Execute printing.

£ My Tab| Basic | Layou | Gover Mods | Stamp/Compostion | Quaity | other |

Eavorte Setting

8 Defoult Setfng = | Add,

Printer Information

Paper Tray
Auto

Paper Type
No setting

E}fﬂ IDpri

P[] Manually Print on 2nd Side

Job Retention
53 Print
=l

Bl pot and bl
%o;] Secured Job

E‘Q Proaf then Prnt

Print data is saved on the HDD of this machine.
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Using the saved data

1 Tap [Document Print/Delete].

Select function.

Job List Counter

Cor Q Scan To @ Scan To @
24 E-mail Folder

Document &
Print / Delete

2 Tap [Documents to Print].

Select desired function.

F

Utility

b &
Documents to Print ID & Print E"I“e"“"
lemory
Scanned
Documents

3 Select the desired user, then tap [Open].

4 Selecta job to print, then tap [Print].
= To delete a job, tap [Delete].

5 necessary, change the number of copies, then tap [OK].

d-Color MF 3300/3800
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254

Attaching authentication information

Printing when authentication is set

When printing a document in an environment where user authentication or account track is employed, you
need to send the authentication information (user name and password) to this machine to execute printing.
This requirement limits the users who can use this machine, preventing unauthorized use by a third party.

When this machine receives a print job from a user who is not permitted to print, or a print job that does not
contain authentication information, this machine automatically discards the job.

Tips

° A print job that does not contain authentication information is a print job that is sent without correctly
configuring the User Authentication/Account Track setting using the printer driver even though the User
Authentication/Account Track setting is configured on this machine.
The status in which the User Authentication/Account Track setting is not configured correctly means
that the [Auto] check box of [Acquire Settings...] is cleared and [User Authentication]/[Account Track]
of [Device Option] is set to [None] in the [Configure] tab of the [Properties] windows of the printer driver.
In this status, if you select [Print] in [Job Retention] of the [Basic] tab at the time of printing to execute
a print job, it is handled as a print job that does not contain authentication information.

° If [ID & Print] is set to [Enable] on [Security] - [ID & Print Settings] of Web Connection, an ordinary print
job is handled as an ID & Print job (default: [Disable]). For details on the ID & Print function, refer to
page 2-50.

@ Reference

When printing a highly confidential document in an environment where user authentication or account track
is employed, using the ID & Print function enables high security printing. For details, refer to page 2-50.

Operations required to use this function
In the [Configure] tab of the printer driver, check that the User Authentication/Account Track setting is cor-
rectly configured.
1 Display the [Properties] window of the printer driver.
= For information on how to display the [Properties] window, refer to page 2-53.
2 In [Device Option] of the [Configure] tab, check that the User Authentication/Account Track setting is
correctly configured for your operating environment.

=> Ifitis not configured correctly, select [User Authentication] or [Account Track] from the list, then
change the relevant setting in [Setting].

) - Lo e | Propertie:

| General | Sharing [ Ports | Advanced | Color Management | Securiy | Configurs | Settings

Device Option
0| EHoD)

Hard Disk Installed

Paper Source Unt 2 None:

Paper Source Lint 3 None
Authentication Ol

Model

Account Track Encble

Acqure Device information
Acquire Settings.

Software Tools

‘Web Connection -

EY

ok ][ Cencel ][ ooy ][ Hep

3 Click [OK].
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How to print from the computer

1 In the [Basic] tab, click [Authentication/Account Track...]

= Printing Preferen:

I £ My Tab|Basic_{ Layout [ Cover Mode | Stamp/Composition | Gualy | ther |

Favorite Settir -
8 1721 @501 i) Eavorte Seting Uritled

Original Orentation Job Retention

© Pottrait
(@) Landscape E‘ﬂ Pint M
s1/2011 -
Authentication/Account Track
& Paper Size
‘Same a5 Original Size L | Coies
1 =) [1..9999]

Zoom [25..400%]
- ® ff“ ‘ =R @l@l [ Collte

© Marual
=8

Paper Tray
D ) Auto vy
</ () Manualy Pt o 2nd Side
5 & Paper Type
B 23 Noseting .

Printer Information

2 When user authentication is enabled, select [Recipient User], then enter the user name and password.

= Ifaccess to this machine by public users (unregistered users) is allowed, you can select [Public User]
and print data without entering the user name and password.

- When an external authentication server is used, click [Server Setting...] and select the authentication
server.

|| User Authentication Account Track
©) Public User Department Name
© Hecipient User

User Name s

Pgssword

‘Server Setting

3 If account track is enabled, enter the account name and password.

|| User Authentication Account Track
©) Public User Department Name
© Hecipient User

User Name s

Pgssword

‘Server Setting

4 Click [OK].
= If a communication with this machine is established, you can click [Verify] to check the entered au-
thentication information. Also, you can check the authentication information for errors before print-
ing it.
5  Execute printing.

Printing starts successfully when the authentication information is judged correct.
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2.5.5

Printing at the same time as authentication (ID & Print)

ID & Print

ID & Print is a function that saves print data to the HDD of this machine when user authentication is employed.
Because the data is not printed straight away, this function prevents printed materials from going missing or
being left unattended.

To print data from the HDD, you need to perform user authentication on this machine; this function is par-
ticularly suitable for safely printing highly confidential documents. When you are successfully authenticated,
the print data of the login user is automatically printed. This enhances security as well as ensures smooth
operation.

@ Reference

User Authentication/Account Track can only be configured using Web Connection. For details, refer to Chap-
ter 1 in [User's Guide Applied Functions].

To enable the ID & Print function, select [Security] - [ID & Print Settings] in the Web Connection administrator
mode, then set [ID & Print] to [Enable]. For details, refer to Chapter 1 in [User's Guide Applied Functions].

How to print from the computer

1 In [Job Retention], select [ID & Print].

£ My Tab| Basic | Layout | Cover Mode | Stamp/Composition | Guaity | Gther |

Favorte Setting R Defaut Settng  + | Add.
Oniginal Oriertation Job Retention
® Porrait
© Landscape E’j Ft
Orginal Size: =l
B1/2c11 -
B swore ob
& Poper Size =
Same as Original Size - Eﬂ Print and Hold
Zoom [25..400%] g;j Seoured Job

@ Ato

100 %
© Manual B Frocthen e
Paper Tray =5 10em
Auto

) Manualy Pirt on 20 Sice
Paper Tye

No setting -

2 n [Authentication/Account Track...] of the [Basic] tab, enter authentication information, then click [OK].

= For details, refer to page 2-48.

3 Execute printing.

Print data is saved on the HDD of this machine. Continue to "Operations on this machine".
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Operations on this machine (Printing simultaneously with login)
You can print all data saved by the ID & Print function simultaneously when performing authentication on this
machine.

1 Enter the user name and password.

2 Check that [ID & Print] is selected in [ID & Print/MFP Access], then tap [Login].

- When an optional Authentication Unit is used, you can switch [Device Authentication] and [Authen-
tication Unit] in [Authentication Method].

Enter User Name and Password, 2013/06/14 1%20
-

and touch Login or Access. W

Ki

Authentication Method ID & Print
ID & Print/MFP Access ]

Access
Basic Screen I

g)

User Name

Password

Server

A

If authentication succeeds, all the saved data is printed.

- After data has been printed, do not log in to the machine.

= To change the default settings of [ID & Print] (default: [ID & Print/MFP Access]), select [Security] -
[ID & Print Settings] - [Default Operation Selection] in the Web Connection administrator mode.

Operations on this machine (Printing only specific data)
You can log in to this machine and specify data to be printed if you like to print only specific data.

1 Enter the user name and password.

2 n [ID & Print], select [Access Basic Screen], then tap [Login].

Enter User Name and Password, 2013/06/14 16;20
-

and touch Login or Access. o

K

Authentication Method ID & Print

ID & Print/MFP Access | Public
User
Access
Basic Screen I
g

I =)

User Name

Password

Server

£
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3 Tap [Document Print/Delete].

Select function.

Job List Counter

c Q Scan To @ Scan To @ F
oPY E-mail Folder ax

) &
Document Utilit
Print / Delete ity

4 Tap[ID & Print].

Select desired function.

. &

Documents to Print ID & Print

External
Memory

Scanned
Documents

5 Tap [Login User].

Select user.

C 1) B

Public User Login User ‘

6  Select data to be printed, then tap [Print].

= To delete data, tap [Delete].
The printed data is deleted from the HDD.
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2.6 Printer driver setting items

2.6.1 [Properties] window of the printer driver

How to display the [Properties] window

The printer driver has two windows for configuring settings: the [Properties] window and the [Printing Prefer-
ences] window. This section describes the [Properties] window.

In the [Properties] window, you can configure settings for the optional environment of this machine or Win-
dows functions. To display the [Properties] window, take the following steps:

Display the printer window.

>

>

>

In Windows 8, right-click the Start window, then click [All apps] - [Control Panel] - [Hardware and
Sound] - [View devices and printers].

In Windows Server 2012, open the Start window, then click [Control Panel] - [Hardware] - [View de-
vices and printers].

In Windows 7/Server 2008 R2, open the Start menu, then click [Devices and Printers].
If [Devices and Printers] is not displayed, select [Control Panel] - [Hardware and Sound], and click
[View devices and printers].

In Windows Vista/Server 2008, click the Start menu, and select [Control Panel] - [Hardware and
Sound] - [Printers].
When [Control Panel] is displayed in Classic View, double-click [Printers].

In Windows XP/Server 2003, click the Start menu, then select [Printers and Faxes].
If [Printers and Faxes] is not displayed, select [Control Panel] - [Printers and Other Hardware] -
[Printers and Faxes]. When [Control Panel] is displayed in Classic View, double-click [Printers].

Open the printer properties.

>

>

In Windows 7/8/Server 2008 R2/Server 2012, right-click the icon of the installed printer, and from
[Printer properties], click the displayed printer name.

In Windows XP/Vista/Server 2003/Server 2008, right-click the icon of the installed printer, then click
[Properties].

The [Properties] window appears.

Tabs provided by Windows

The [General], [Sharing], [Port], [Advanced], [Color Management], and [Security] tabs are provided by Win-

dows.

You can print a test page, configure printer sharing, configure printer ports, etc. For details, refer to the Win-
dows manuals.
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2.6.2 Available operations in the [Configure] tab

You can specify which optional devices are installed on this machine using the [Configure] tab. You can au-
tomatically obtain information of this machine to manually configure settings.

Settings Description

[Device Option] The model name, options installed on this machine, and authentication set-
tings of this machine are displayed.

When the settings of this machine cannot be obtained, you need to manually
change the settings. Select the item to change from the list, and set a value in

[Setting].
[Acquire Device Infor- Obtains information about which optional devices are installed on this machine
mation] by communicating with this machine.
In [Acquire Settings...], set the method of obtaining the information on this ma-
chine.
[Acquire Settings...] Configure the settings to obtain the information of this machine.
[Auto] Select this check box to automatically obtain the information of this machine.
[Destination Set- Set the communication method to get information from this machine.
tings] e [Device which Connect with Printer Port]: Information is obtained from the

printing port specified in the [Port] tab in the printer driver.
e [Specify IP Address or Printer Name]: Information is obtained by connect-
ing to a device with the entered IP address or printer name.

[Software Tools] You can start up the software tools such as Web Connection.

Tips
° When [Auto] in [Acquire Settings...] is enabled and the computer is unable to communicate with this

machine, the computer takes a long time to display the [Properties] window or the [Printing Preferences]
window.

° If you are using the machine from a Windows XP/Server 2003 computer via USB connection, [Acquire
Device Information] cannot be used.
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Available operations in the [Settings] tab

In the [Settings] tab, you can change the default settings for how confirmation messages are displayed as
well as the window for inputting authentication information.

Settings Description

[EMF Spool] Select this check box when meta file (EMF) spooling is required in your own
system environment.

[Display Constraint Select this check box to display a message indicating that you have selected

Message] printer driver functions that cannot be used together.

[Display paper set in
Print Server Properties]

Select this check box when using the paper added in [Server Properties] in the
printer window.

[Verify Authentication
settings before printing]

Select this check box to enable the [Verify] button in the [User Authentica-
tion/Account Track] dialog box.

[Popup Authentication
Dialog when printing]

Select this check box to display the [User Authentication/Account Track] dia-
log box for printing. This option reminds you to enter the user name and pass-
word.

[Save Custom Size...]

Tips

If you print on odd size paper, specify the size to register the paper.
The registered paper size can be selected from [Original Size] in the [Basic] tab.

° [EMF Spool] is a function of the PCL driver.
° [Save Custom Size...] is a function of the PCL driver.

° The procedure for opening [Server Properties] is as follows:
If you are using Windows 7/8/Server 2008 R2/Server 2012, select a printer, then click [Print Server
Properties] on the toolbar.
If Windows Vista or Windows Server 2008 is running, place the cursor pointer in an empty area of the
[Printers] window, then click the mouse right button. From the shortcut menu, select [Run as adminis-
trator] - [Server Properties].
If Windows XP or Windows Server 2003 is running, click the [File] menu and select [Server Properties].

d-Color MF 3300/3800
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2.6.4

[Printing Preferences] window of the printer driver

How to display the [Printing Preferences] window

The printer driver has two windows for configuring settings: the [Properties] window and the [Printing Prefer-
ences] window. This section describes the [Printing Preferences] window.

The [Printing Preferences] window has multiple tabs on each of which related functions are grouped to enable
you to configure print functions unique to this machine. To display the [Printing Preferences] window, take
the following steps:

Display the printer window.
= In Windows 8, right-click the Start window, then click [All apps] - [Control Panel] - [Hardware and
Sound] - [View devices and printers].

= In Windows Server 2012, open the Start window, then click [Control Panel] - [Hardware] - [View de-
vices and printers].

= In Windows 7/Server 2008 R2, open the Start menu, then click [Devices and Printers].
If [Devices and Printers] is not displayed, select [Control Panel] - [Hardware and Sound], and click
[View devices and printers].

= In Windows Vista/Server 2008, click the Start menu, and select [Control Panel] - [Hardware and
Sound] - [Printers].
When [Control Panel] is displayed in Classic View, double-click [Printers].

= In Windows XP/Server 2003, click the Start menu, then select [Printers and Faxes].
If [Printers and Faxes] is not displayed, select [Control Panel] - [Printers and Other Hardware] -
[Printers and Faxes]. When [Control Panel] is displayed in Classic View, double-click [Printers].

Open [Printing Preferences].

= In Windows 7/8/Server 2008 R2/Server 2012, right-click the icon of the installed printer, and from
[Printing preferences], click the displayed printer name.

= In Windows XP/Vista/Server 2003/Server 2008, right-click the icon of the installed printer, and click
[Printing Preferences...].

The [Printing Preferences] window of the printer appears.

Tips
The print settings changed here are registered as default values. When you want to temporarily change set-

tings to print from application software, click [Properties] (or [Preferences]) in the [Print] window to open the
[Printing Preferences] window.

Items common to each tab

The following explains the commonly used settings and buttons in each tab.

Settings Description

[Favorite Setting] You can register the current print settings as a favorite and recall it when exe-
cuting printing.
For details on the [Favorite Setting], refer to page 2-14.

View Selecting [Paper View] displays a sample page layout based on the current set-
tings for checking the output result image.

Selecting [Printer View] displays a printer figure showing the options, such as
paper trays, installed in the machine.

[Printer Information] Click this button to start Web Connection and check the printer information.
This button is enabled only when your computer can communicate with this
machine.

[OK] Applies the changes made to the settings and closes the setting window.

[Cancel] Discards (or cancels) the current changes and closes the setting window.

[Help] Displays the help for each item in the window.

[Default] Initializes the current settings.
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2.6.5 Available operations in [Advanced]

[Advanced] is a tab to configure detailed settings for PostScript. This function is only available for the PS driv-

er.
Settings Description
[Advanced Printing Select whether or not to enable the booklet print setting.
Features:]
[PostScript Options] Configure the PostScript option setting.

e [PostScript Output Option]: Select the method to output a PostScript file.

e [Send PostScript Error Handler]: Select whether or not to print a report
when a PostScript error has occurred.

e [Mirrored Output]: Select whether or not to print an image in mirror-re-
versed mode.

[PostScript Pass
through]

Tips

Select whether or not to allow the application to print data directly without us-
ing the printer driver.

[Advanced Printing Features:] is displayed when the [Enable advanced printing features] check box is select-
ed in the [Advanced] tab of the [Properties] window.

2.6.6 Available operations in [My Tab]

[My Tab] allows you to customize the display contents.

You can gather setting items from difference tabs and place them in [My Tab]. Registering frequently used
setting items in [My Tab] allows you to change settings in one tab, without switching among multiple tabs.

For details on how to edit [My Tab], refer to page 2-16.

Settings

Description

[More Details]

Click this button to display the Help of [My Tab].

[Do not show again]

Select this check box if you do not want to display the comment field contain-
ing [More Details].

[Edit My Tab...]

Click this button to register or delete the functions displayed in [My Tab].
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2.6.7

Available operations in [Basic]

In the [Basic] tab, you can configure basic settings about paper or printing. Functions that are frequently used
in normal printing are placed in this tab.

Settings

Description

[Original Orientation]

Specify the orientation of the original created in application software.
If the setting in the printer driver differs from the one specified in the application
software, correct the setting.

[Criginal Size]

Select the size of the original created in application software.

If the setting in the printer driver differs from the one specified in the application
software, correct the setting.

To print on custom sized paper, select [Custom Size] and specify the width and
length. For details, refer to page 2-18.

[Paper Size] Select the size of paper for printing.
If the size of the paper is different from that of the original size, and if [Zoom] is
set to [Auto], the original is sent by enlarging or reducing it according to the se-
lected paper size.
To print on custom sized paper, select [Custom Size] and specify the width and
length. For details, refer to page 2-18.
[Zoom] Select how the print image is enlarged or reduced.
¢ [Auto]: The image is enlarged or reduced according to the size of the paper
specified in [Paper Size].
e [Manual]: The image is enlarged or reduced by the specified ratio (25 to
400%).
[Paper Tray] Select the paper tray for the printing paper.
When you select [Auto], the tray containing the paper selected in [Paper Size] is
automatically used.
[Paper Type] When you have selected [No setting] in [Paper Tray], select the paper type for

printing. Selecting [No setting] applies the paper type specified on [Utility] - [Us-
er Settings] - [Printer Settings] - [Paper Setting] - [Paper Tray] on the Control
Panel.

[Job Retention]

Select the method to use to print the original from this machine.

[Print]

Select this option to print normally.

[Store Job]

Select this option to save the original on the HDD of this machine.
For details, refer to page 2-46.

[Print and Hold]

Select this option to save the original on the HDD of this machine and simulta-
neously execute a print job.
For details, refer to page 2-46.

[Secured Job]

Select this option to print highly confidential documents. Printing is carried out
when the password is entered on this machine.
For details, refer to page 2-44.

[Proof then Print]

Select this option to print a large number of copies. This machine prints only one
copy and waits for the user's command before printing the remaining copies.
For details, refer to page 2-42.

[ID & Print]

Select this option to print highly confidential documents in an environment
where user authentication is employed. Printing is allowed when the user is au-
thenticated to use this machine.

For details, refer to page 2-50.

[User Settings...]

Enter the required information when [Secured Job] is selected in [Job Reten-
tion].

[Authentication/Ac-
count Track...]

When user authentication or account track is employed, enter the user name or
account name and the password. For details, refer to page 2-48.

[Copies]

When printing multiple sets of copies, specify the number of sets.

[Collate]

When printing multiple sets of copies, select this check box to output sets of
copies one by one.

When this check box is cleared, the first page of the original is printed on as
many sheets as the number specified in [Copies], and then each of the subse-
quent pages is printed in this manner.
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Settings Description

[Manually Print on 2nd Select this check box to print on the back side of a sheet that has been printed
Side] on once.

When specifying [Manually Print on 2nd Side] for printing, use the back side of
the sheet printed on this machine. The printing result with this setting is exclud-
ed from assurance.

2.6.8 Available operations in the [Layout] tab

In the [Layout] tab, you can configure layout settings for printing. You can combine pages or adjust print po-

sitions.
Settings Description
[Combination] Select how the original pages are combined on sheets.
e [2in1)/[4in1)/[6in 1)/[9in 1)/[16in 1]:
Multiple pages are reduced and printed on the same side of one sheet. For
example, when you select [9 in 1], the size of every set of nine pages is re-
duced and printed on the same side of one sheet.
[2 x 2]/[3 x 3)/[4 x 4] (PCL only):
The original image is enlarged, divided and printed on multiple sheets. For exam-
ple, when you select [2 x 2], one page of the original is divided and printed on four
sheets. When you join the printed sheets together, a large poster is created.

If necessary, click [Combination Details...] to configure detailed settings about

page combination.

e [Combination]: Select the page combination.

e [Layout Order]: When you have selected "N in 1" in [Combination], select
the order of pages in the layout.

e [Border]: When you have selected "N in 1" in [Combination], select this
check box if you want to draw border lines between pages. In addition, se-
lect the type of border lines.

e [Overlap width line]: When you have selected "N x N" in [Combination], se-
lect this check box if you want to create overlap margins.

[Rotate 180] Select this check box to rotate the original 180 degrees and print it.

[Skip Blank Pages] Select this check box to exclude blank pages in the original from the pages to
be printed.

[Print Type] Select the print sides of paper.

e [1-Sided]: The original is printed on one side of a sheet of paper.

e [2-Sided]: The original is printed on both sides of a sheet of paper.

e [Booklet]: The original is printed in booklet format. Original pages are sort-
ed and printed on both sides of sheets in two-page spread mode. When
the printed sheets are collectively folded in two, they are arranged in the
page order like a book. If necessary, click [Booklet Details...], then specify
the binding position and whether or not to draw border lines.

[Binding Position] Select the binding position.
[Binding Margin] Select this check box to provide a margin on printed sheets.

Click [Binding Margin Settings...] to specify the size of the margin in detail.

¢ [Shift Mode]: Select how the images are shifted for creating the margin.

e [Front Side]: Specify the size of the margin on the front side.

e [Back Side]: When you print on both sides, specify the size of the margin
on the back side. When the [Same value for front and back sides] check
box is selected, a margin of the same size is created on both the front and
back sides.

[Image Shift] Select this check box to fine-tune (shift) the print position of the image with re-
spect to the paper.

C|ICk [Image Shift Settings...] to specify the print position in detail.

[Front Side]: Specify the upward/downward and rightward/leftward shift
distances for the front side.

e [Back Side]: When you print on both sides, specify the upward/downward
and rightward/leftward shift distances for the back side.
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2.6.9 Available operations in the [Cover Mode] tab

In the [Cover Mode] tab, you can insert covers and pages.

Settings

Description

[Front Cover]

Select this check box to insert and print on a front cover. In [Front Cover Tray],

select the paper tray for the front cover. Then, select whether or not to print on

the inserted front cover.

¢ [Blank]: Nothing is printed on the inserted front cover.

e [Printed (1-Sided)]: Select this option to print on one side of the sheet that
is inserted as a front cover.

¢ [Printed (2-Sided)]: Select this option to print on both sides of the sheet that
is inserted as a front cover.

You can set this option when you have selected anything other than [Auto] in

[Paper Tray] in the [Basic] tab.

[Back Cover]

Select this check box to insert and print on a back cover. In [Back Cover Tray],

select the paper tray for the back cover. Then, select whether or not to print on

the inserted back cover.

e [Blank]: Nothing is printed on the inserted back cover.

e [Printed (1-Sided)]: Select this option to print on one side of the sheet that
is inserted as a back cover.

e [Printed (2-Sided)]: Select this option to print on both sides of the sheet that
is inserted as a back cover.

You can set this option when you have selected anything other than [Auto] in

[Paper Tray] in the [Basic] tab.

[Separator Page]

Select this check box when inserting a separator sheet for each job or copy to
make prints. Then, select the position to insert a separator page from [Header
(Each Job)], [Header (Each Copy)], and [Trailer (Each Copy)]. In [Separator
Page Tray], select a paper tray to load sheets to be used as separator pages.
You can set this option when you have selected anything other than [Auto] in
[Paper Tray] in the [Basic] tab.

2.6.10 Available operations in the [Stamp/Composition] tab

In the [Stamp/Composition] tab, you can configure settings for adding text or an image to the original.

Settings

Description

[Watermark]

Select this check box to print a watermark (text stamp) on the original. In addi-
tion, from the list, select the watermark you want to print.

Clicking [Edit...] allows you to register or edit a watermark. For details, refer to
page 2-29.

[Copy Protect] (PCL
only)

Select this check box to print a text such as "Copy" or "INTERNAL USE" in the
background pattern as concealed text.

When you click [Edit...], you can configure detailed settings such as Copy Pro-
tect printing items or the printing method. For details, refer to page 2-32.

[Create Overlay File]
(PCL/XPS)

Select this check box to save data created in application software on the com-
puter as an overlay image to be composed on the original. For detalils, refer to
page 2-31.

[Print in Overlay]

Select this check box to compose the created overlay image on the original
when printing. For details, refer to page 2-30.
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2.6.11 Available operations in the [Quality] tab

In the [Quality] tab, you can configure settings for the image quality of the original. You can specify colors,
image processing, and font processing.

ltems that can be specified vary depending on your printer driver.

Settings Description

[Select Color] Select colors for printing.

¢ [Auto Color]: The color mode is automatically selected according to the
original color.

e [Gray Scale]: The original is printed in black and white regardless of wheth-
er or not the original is in color or in black and white.

[Quality Adjustment...] Adjust the brightness and contrast to fit the original.

[Color Settings] Select the optimum color setting mode for the original.

e [Auto]: The color setting suitable for originals is applied automatically.

¢ [Photo]: The color setting that prioritizes the image quality is applied.

e [Presentation]: The color setting suitable for originals containing both text
and figures is applied.

e [ICM] (PS only): The color setting is applied using the Windows ICM func-
tion. When you click [Details...], you can specify the ICM method and ob-
jectives.

¢ [Custom]: Manually configure the color setting for each object (image, text,
or graphics) in the original. For details, refer to page 2-36.

e [Disable] (PCL/PS): Prints without performing color conversion.

[Resolution] (PCL/PS) Select the print resolution.

[Pattern] (PCL/XPS) Select the pattern density.
[Image Compression] Select the compression mode for the image data contained in the original.
(PCL only) ¢ [Best Quality]: The process prioritizes quality. Quality is improved, but

printing takes a long time.
e [Maximum Compression]: The process prioritizes speed. The printing time
is shortened, but the printing quality is deteriorated.

[Glossy Mode] Select this check box to print images with a glossy finish. The printing speed
is reduced.

[Toner Save] Select this check box to save the amount of toner consumed. The printing den-
sity is reduced.

[Edge Strength] Select this check box to sharpen small or faint characters, then specify the
strength level.

[Font Settings] Specify how to process texts.

(PCL/PS) Select a type of font to be downloaded from the computer to this machine.
Also specify whether or not replace the TrueType fonts by printer fonts when
printing.

If characters are garbled in an environment where the PCL driver is used, we
recommend that you select [Bitmap] in [Download Font Format] and clear the
[Use Printer Fonts] check box.
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2.6.12 Available operations in the [Other] tab

In the [Other] tab, you can check the driver version and configure print settings for application software.

Settings

Description

[Excel Job Control]

Select this check box to print multiple Microsoft Excel sheets with different
page settings at one time.

When multiple sheets with different page settings are printed at one time, the
sheets may be separated into single-sheet jobs depending on the data con-
tained. This function avoids job separation as much as possible.

[Remove White Back-
ground] (PCL/XPS)

Select this check box to superimpose an overlay image on Microsoft Power-
Point data.

White areas are removed so that the white background of the PowerPoint data
does not hide the overlay image. Clear this check box to print the original as is
without removing the background.

[Thin Line Support]
(PCL only)

Select this check box to perform reduced-size printing. This function prevents
thin lines from disappearing.

This is effective for thin lines such as table borders created in Excel, but not for
thin lines used in illustrations.

[Check Driver Version]

Tips

° [Excel Job Control] and [Remove White Background] are not available depending on a specific environ-

The version of the printer driver is displayed.

ment or application software.
. You can change the [Excel Job Control] setting only when the printer driver setting dialog box is dis-

played on the [Printers] ([Devices and Printers] in Windows 7/8/Server 2008 R2/Server 2012 and [Print-

ers and Faxes] in Windows XP/Server 2003) window.
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Uninstalling the printer driver 2

2.7

Uninstalling the printer driver

Using the deletion program

If the printer driver was installed using the installer, the uninstallation function for the printer driver is also in-
stalled.

v

Administrator privileges are required to perform this task.

Start the deletion program.

= From the Start menu, click [All Programs] (or [Programs]) - [MFP-Printer Utility] - model name of this
machine - [Uninstall Printer Driver].

= In Windows 8, right-click the Start window, select [All apps] - [Control Panel] - [Programs], then click
[Uninstall a program]. Double-click the driver to be uninstalled in the list.

= In Windows Server 2012, open the Start window, then click [Control Panel] - [Programs] - [Uninstall
a program]. Double-click the driver to be uninstalled in the list.

Select the printer driver you want to uninstall, then click [Uninstall].

= Follow the subsequent on-screen instructions.

If the dialog box prompting to restart the computer appears, click [OK].

Uninstallation of the printer driver is then completed.

Uninstall using the installer

If you have installed the driver using the installer, you can use the installer to uninstall the driver.

v

Administrator privileges are required to perform this task.

Insert the printer driver CD/DVD-ROM into the CD/DVD-ROM drive of the computer.

- Make sure that the installer starts, then proceed to Step 2.

= If the installer does not start, open the printer driver folder on the CD/DVD-ROM, double-click [Set-
up.exe], then go to Step 3.

Click [Printer/FAX].

The printer driver installer starts.

Click [AGREE] in the license agreement window.

Check the contents of the [Readme] window, then click [Next].
Select [Uninstall Printer Driver], then click [Next].

Select the printer driver you want to uninstall, then click [Uninstall].

- Follow the subsequent on-screen instructions.

If a dialog box prompting you to restart the computer appears, click [OK] to restart the computer.

Uninstallation of the printer driver is then completed.
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3.1 Preparation for printing (Bonjour connection) 3

i
3

3.1

3.1.1

3.1.2

Printing in the Mac OS Environment

Preparation for printing (Bonjour connection)

Overview

Before using this machine as a printer, you need to install the printer driver on your computer and add the
printer to your computer.

This section describes preparations required to carry out printing on this machine by Bonjour (Rendezvous)
connection that is supported in Mac OS X 10.3 or later.

Tips

. The Bonjour technology enables you to configure the network settings for networked devices and find
and use services without the need for configuring special settings.

° In Mac OS X 10.3, Bonjour is called Rendezvous.

Before setting up the computer (for administrators)

Connecting this machine to the network
B Checking a LAN cable for connection

\4

Configuring the Bonjour settings
B Enabling Bonjour
B Setting a printer name (Bonjour name)
- Enter the name of this machine to be displayed as the name of a connected device.

4

Preparation finished

Checking a LAN cable for connection
Check that a LAN cable is connected to the LAN port of this machine.

For details on the cable connection port, refer to page 1-5.

Configuring the Bonjour settings

Enable Bonjour. (You can use this function with the default settings unless otherwise requested.) In addition,
enter the name of this machine (Bonjour name) to be displayed as the name of a connected device.

For details on how to configure settings, refer to Chapter 1 in [User's Guide Applied Functions].
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3.1.3

Setting up the computer

Preparing the printer driver
B Preparing the printer driver CD/DVD-ROM
=> For the CD/DVD-ROM, contact the administrator of this machine.
B Checking the operating systems supported by the printer driver
- Check that your computer meets the operating environment requirements of the printer driver.

4

Installing the printer driver to the computer
B Installing the printer driver using the installer

= Mount the Drivers & Utilities CD/DVD-ROM disk on the drive, and install the software by following
the on-screen instructions.

B Adding the printer
- Add the printer automatically detected by Bonjour to the computer.

4

Preparation finished

Preparing the printer driver CD/DVD-ROM

The following CD/DVD-ROMs are supplied with this machine: The printer driver is included on the Drivers &
Utilities CD/DVD-ROM.

CD/DVD-ROM Description

Drivers & Utilities CD/DVD-ROM Contains Windows printer driver (PCL/PS/XPS/FAX), Mac OS
printer driver, Linux printer driver, and TWAIN driver. It also
contains the download page of the utility software.

User's Guide CD/DVD-ROM Contains user's guides.

Checking the operating systems supported by the printer driver

The following lists the printer drivers included on the CD/DVD-ROMSs supplied with this machine and the sup-
ported operating systems.

Printer driver ‘ Page description language ‘ Supported operating systems

PostScript PPD driver (PS- PostScript 3 Emulation Mac OS X (10.3.x, 10.4.x, 10.5.x, 10.6.x,
PPD) 10.7.x, 10.8.x)
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Installing the printer driver

Install the printer driver using the installer.

v
1
2

Before installation, exit all application software programs that are running.
Mount the Drivers & Utilities CD/DVD-ROM disk into the CD/DVD-ROM drive of the computer.

Open the folder on the CD/DVD-ROM that contains the desired printer driver.

- Select the folder according to the printer driver, operating system, and language to be used.

Copy the driver file onto the desktop according to the Mac OS X version.

Mac OS X 10.3: model name of this machine_103104.pkg
Mac OS X 10.4: model name of this machine_103104.pkg
Mac OS X 10.5: model name of this machine_105.pkg
Mac OS X 10.6: model name of this machine_106.pkg
Mac OS X 10.7: model name of this machine_106.pkg
Mac OS X 10.8: model name of this machine_106.pkg

In Mac OS X 10.5 or later, the driver folder varies depending on the paper size. Select the appropri-
ate folder to suit your environment.

To mainly use the metric-based paper size such as A4 size: "WW_A4" folder

To mainly use the inch-based paper size such as letter size or 8 1/2 x 11: "WW_Letter" folder

R N N 2 7

Double-click the file copied onto the desktop.

The printer driver installer starts.

Click [Continue] following the instructions on the pages that follow until the [Install] page appears.

- When the name and password prompt appears during the procedure, enter the administrator name
and password.

Click [Install].

The printer driver is installed on the computer.

Click [Close].

The installation process of the printer driver is then completed. Then, add the printer to the computer.

d-Color MF 3300/3800 3-5



Preparation for printing (Bonjour connection) 3.1

Configuring connection using Bonjour (Mac OS X 10.4 or later)

Add the printer automatically detected by Bonjour to the computer.
Select [System Preferences...] in the Apple menu.
Click the [Print & Fax] or [Print & Scan] icon.

Click [+] on the [Print & Fax] or [Print & Scan] window.

= In Mac OS X 10.4/10.5/10.6, go to Step 4.

= InMac OS X 10.7/10.8, if a target printer name is found in the list displayed by clicking [+], select it.
When a printer driver is selected automatically, the printer addition is completed. If a target printer
name is not found, select [Add Other Printer or Scanner...] or [Add Printer or Scanner...], and go to
Step 4.

Click [Default].

Connected printers are detected.
= If no printers are detected, restart this machine.

From the [Printer Name] list, select the desired printer for a Bonjour connection.

= To check the printer name, select [Network] - [Bonjour Setting] in the administrator mode of Web
Connection.

- By default, () at the end of the printer name corresponds to the last three bytes of the MAC address.

The printer driver for the selected printer is displayed in [Print Using:].

= When the printer driver is displayed, go to Step 7.

= When the printer driver is not correctly displayed, go to Step 6.

Manually select the printer driver.
= In Mac OS X 10.6 or later, select [Select Printer Software...] in [Print Using:], then click the driver of
the desired printer from the list that is displayed in another window.

= InMac OS X 10.5, select [Select a driver to use...] in [Print Using:], then click the driver of the desired
printer from the list.

= In Mac OS X 10.4, select [GENERIC] in [Print Using:], and then click the driver of the desired printer
from the list.
Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window
to configure the optional environment for this machine. For details, refer to page 3-7.
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Configuring connection using Rendezvous (Mac OS X 10.3)
Add the printer automatically detected by Rendezvous to the PC.
From [Macintosh HD] (hard disk of the system) - [Applications] - [Utilities], double-click [Printer Setup
Utility] or [Print Center] to open it.
When the [You have no printers available.] window appears, click [Add]. When the [Printer List] appears,
click [Add].
=> If available printers have already been specified, the [You have no printers available.] window does
not appear.
Select [Rendezvous] as the connection method.
Connected printers are detected.
= If no printers are detected, restart this machine.
From the [Name] list, select the desired printer for Rendezvous connection.
= To check the printer name, select [Network] - [Bonjour Setting] in the administrator mode of Web
Connection.
- By default, () at the end of the printer name corresponds to the last three bytes of the MAC address.
Manually select the printer driver.
= In [Printer Model:], select [GENERIC], then click the driver of the desired printer from the model list.
Click [Add].
The addition process of the printer is then completed. Then, proceed to the [Installable Options] window
to configure the optional environment for this machine. For details, refer to page 3-7.
3.14 Initializing the printer driver

Configuring the optional environment of this machine

When you use this machine for the first time, properly configure the printer driver so that it contains informa-
tion such as the options installed on this machine.

Open the [Print & Fax] (or [Print & Scan]/[Printer Setup Utility]/[Print Center]) window.

= The [Print & Fax] or [Print & Scan] window can be opened from [System Preferences...] in the Apple
menu (Mac OS X 10.4 or later).

= The [Printer Setup Utility]/[Print Center] window can be opened from [Macintosh HD] (hard disk of
the system) - [Applications] - [Utilities].
Display the [Printer Information] window.

= For the [Print & Fax]/[Print & Scan] window, click [Options & Supplies...] (Mac OS X 10.5 or later) or
[Printer Setup...] (Mac OS X 10.4).

= For the [Printer Setup Utility]/[Print Center] window, click [Show Info] of the [Printer] menu.

Display the [Installable Options] window.

= In Mac OS X 10.5 or later, click [Driver].
= In Mac OS X 10.3/10.4, select [Installable Options].

Change the settings according to the options installed on this machine.

Click [OK] or [Apply Changes] to close the [Printer Information] window.
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Changing the default print settings

In the [Page Setup] window of the printer driver, you can change the default settings for paper and zoom ratio.

1 Display the [Page Setup] window of the printer driver.

= For information on how to display the [Page Setup] window, refer to page 3-34.

2 Change the settings, and select [Save As Default] from [Settings:].
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3.2 Preparation for printing (USB connection)
3.2.1 Overview
Before using this machine as a printer, you need to install the printer driver on your computer and add the
printer to your computer.
This section describes preparations required to carry out printing on this machine by USB connection.
3.2.2 Setting up the computer

Preparing the printer driver
B Preparing the printer driver CD/DVD-ROM
=> For the CD/DVD-ROM, contact the administrator of this machine.
B Checking the operating systems supported by the printer driver
- Check that your computer meets the operating environment requirements of the printer driver.

Y/

Installing the printer driver to the computer
B Installing the printer driver using the installer

= Mount the Drivers & Utilities CD/DVD-ROM disk on the drive, and install the software by following
the on-screen instructions.

B Adding the printer
= Add the printer that is automatically detected by USB connection to the computer.

A4

Preparation finished

Preparing the printer driver CD/DVD-ROM

The following CD/DVD-ROMs are supplied with this machine: The printer driver is included on the Drivers &
Utilities CD/DVD-ROM.

CD/DVD-ROM Description

Drivers & Utilities CD/DVD-ROM Contains Windows printer driver (PCL/PS/XPS/FAX), Mac OS
printer driver, Linux printer driver, and TWAIN driver. It also
contains the download page of the utility software.

User's Guide CD/DVD-ROM Contains user's guides.

Checking the operating systems supported by the printer driver

The following lists the printer drivers included on the CD/DVD-ROMSs supplied with this machine and the sup-
ported operating systems.

Printer driver ‘ Page description language ‘ Supported operating systems
PostScript PPD driver (PS- PostScript 3 Emulation Mac OS X (10.3.x, 10.4.x, 10.5.x, 10.6.x,
PPD) 10.7.x, 10.8.x)
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Preparation for printing (USB connection) 3.2

Installing the printer driver

Install the printer driver using the installer.

v

Before installation, exit all application software programs that are running.
Mount the Drivers & Utilities CD/DVD-ROM disk into the CD/DVD-ROM drive of the computer.

Open the folder on the CD/DVD-ROM that contains the desired printer driver.

- Select the folder according to the printer driver, operating system, and language to be used.

Copy the driver file onto the desktop according to the Mac OS X version.

Mac OS X 10.3: model name of this machine_103104.pkg
Mac OS X 10.4: model name of this machine_103104.pkg
Mac OS X 10.5: model name of this machine_105.pkg
Mac OS X 10.6: model name of this machine_106.pkg
Mac OS X 10.7: model name of this machine_106.pkg
Mac OS X 10.8: model name of this machine_106.pkg

In Mac OS X 10.5 or later, the driver folder varies depending on the paper size. Select the appropri-
ate folder to suit your environment.

To mainly use the metric-based paper size such as A4 size: "WW_A4" folder

To mainly use the inch-based paper size such as letter size or 8 1/2 x 11: "WW_Letter" folder

R N N 2 7

Double-click the file copied onto the desktop.

The printer driver installer starts.

Click [Continue] following the instructions on the pages that follow until the [Install] page appears.

- When the name and password prompt appears during the procedure, enter the administrator name
and password.

Click [Install].

The printer driver is installed on the computer.

Click [Close].

The installation process of the printer driver is then completed. Then, add the printer to the computer.

Configuring USB connection settings (Mac OS X 10.5 or later)

Add the printer that is automatically detected by USB connection to the computer.

Connect a USB cable to the USB port of this machine.

= For details on the cable connection port, refer to page 1-5.
Select [System Preferences...] in the Apple menu.
Click the [Print & Fax] or [Print & Scan] icon.

Click [+] on the [Print & Fax] or [Print & Scan] window.

- In Mac OS X 10.4/10.5/10.6, go to Step 4.

= InMac OS X 10.7/10.8, if a target printer name is found in the list displayed by clicking [+], select it.
When a printer driver is selected automatically, the printer addition is completed. If a target printer
name is not found, select [Add Other Printer or Scanner...] or [Add Printer or Scanner...], and go to
Step 4.

Click [Default].

Connected printers are detected.
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Preparation for printing (USB connection) 3

=> If no printer is detected, check that this machine is turned on and the USB cable is connected, then
restart the computer.

From the [Printer Name] list, select the desired printer that is connected via the USB port.

The printer driver for the selected printer is displayed in [Print Using:].

Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window
to configure the optional environment for this machine. For details, refer to page 3-7.

Configuring USB connection settings (Mac OS X 10.4)

Connect a USB cable to the USB port of this machine.

=> For details on the cable connection port, refer to page 1-5.

Select [Macintosh HD] (hard disk of the system) - [Applications] - [Utilities], then double-click [Printer
Setup Utility] to open the dialog box.

In the [Printer List] window, click [Add].

Connected printers are detected.
= If no printer is detected, check that this machine is turned on and the USB cable is connected, then

restart the computer.
From the list, select the desired printer that is connected via the USB port.

The printer driver for the selected printer is displayed in [Print Using:].

Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window
to configure the optional environment for this machine. For details, refer to page 3-7.

Configuring USB connection settings (Mac OS X 10.3)

Connect a USB cable to the USB port of this machine.
= For details on the cable connection port, refer to page 1-5.

Select [Macintosh HD] (hard disk of the system) - [Applications] - [Utilities], then double-click [Printer
Setup Utility] to open the dialog box.

In the [Printer List] window, click [Add].

Select [USB] as the connection method.

Connected printers are detected.
=> If no printer is detected, check that this machine is turned on and the USB cable is connected, then

restart the computer.
From the list, select the desired printer that is connected via the USB port.

The printer driver for the selected printer is displayed in [Print Using:].

Click [Add].

The addition process of the printer is then completed. Then, proceed to the [Installable Options] window
to configure the optional environment for this machine. For details, refer to page 3-7.
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3.2.3 Initializing the printer driver

Configuring the optional environment of this machine
When you use this machine for the first time, properly configure the printer driver so that it contains informa-
tion such as the options installed on this machine.

Open the [Print & Fax] (or [Print & Scan]/[Printer Setup Utility]/[Print Center]) window.

= The [Print & Fax] or [Print & Scan] window can be opened from [System Preferences...] in the Apple
menu (Mac OS X 10.4 or later).

= The [Printer Setup Utility]/[Print Center] window can be opened from [Macintosh HD] (hard disk of
the system) - [Applications] - [Utilities].

Display the [Printer Information] window.

= For the [Print & Fax]/[Print & Scan] window, click [Options & Supplies...] (Mac OS X 10.5 or later) or
[Printer Setup...] (Mac OS X 10.4).
= For the [Printer Setup Utility]/[Print Center] window, click [Show Info] of the [Printer] menu.

Display the [Installable Options] window.

= In Mac OS X 10.5 or later, click [Driver].
= In Mac OS X 10.3/10.4, select [Installable Options].

Change the settings according to the options installed on this machine.

Click [OK] or [Apply Changes] to close the [Printer Information] window.

Change the default print settings

In the [Page Setup] window of the printer driver, you can change the default settings for paper and zoom ratio.

Display the [Page Setup] window of the printer driver.

= For information on how to display the [Page Setup] window, refer to page 3-34.

Change the settings, and select [Save As Default] from [Settings:].

3-12 d-Color MF 3300/3800



3.3 How to print 3

3.3 How to print

3.3.1 Printing operation flow
1 Open data of the original using the application software. From the [File] menu, select [Print].

2 Check that the desired printer is selected in [Printer:].

= The [Print] dialog box varies depending on the application software.

3 Specify the print range and the number of copies to print.

= In Mac OS X 10.7/10.8, if the setting items (1) are not displayed, click [Show Details].
= In Mac OS X 10.5/10.6, if the setting items (1) are not displayed, click Eon the right side of [Printer:].

Printer: | Printer Name

Presets: | Default Settings

Copies: |1

Pages: (=) All
(U From: |1 to: |1
() Selected Page in Sidebar
Paper Size: | 8 1/2x11 +| 8.50by11.00 inches

Orientation: ’I:'i| Tor
4|» Preview o «I_ 2

™ Auto Rotate Show Notes
Ied | 4 | 2500f250 [ > | Pb () Scale: 91%
(®) Scale to Fit: (&) Print Entire Image
CFill Entire Paper
Copies per page: 1
(?) | PDF = | | Hide Details Cancel | [ Print |

4 i necessary, switch the menu of application names (2) and change the print settings.
=> The print settings you have changed here return to the default values when you exit the application
software. This is useful to register frequently used print settings as presets. For details, refer to
page 3-14.
5 Click [Print].

Printing is executed.
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3.3.2

Registering frequently used print settings

You can register the current print settings as a preset and recall it when executing printing.

When you register a frequently used combination of print settings as a preset, you can easily apply all of those
settings just by selecting the combination from the presets, even if the combination is complicated as it con-
tains settings on multiple menus.

1

Display the [Print] window of the printer driver.

= For information on how to display the [Print] window, refer to page 3-35.

Change the print settings, and select [Save As...] or [Current Print Settings as Preset] from [Presets:].

Printer: [ Printer Name s

Presets v Standard []
Last Used Settings

Copies

Page:

Paper Size inches

Orientation: s

[ Textdit 2]
[1Print header and footer
<4 4 ) lofl [ >
@ (_PoFv ) ("Cancel ) (Print)

Enter the name of the print setting.

The saved setting can be recalled from [Presets:]. Use a name that helps you easily identify the preset.
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3.4 Useful printing functions

3.4.1 Changing the paper size or type

Enlarging or reducing by the desired zoom ratio ([Scale:])
You can print the original image after it has been enlarged or reduced by the desired zoom ratio.

In [Scale:] of [Page Attributes], specify the zoom ratio.

Settings: | Page Attributes

Format For: | Printer Name
= PPD
Paper Size: | Letter

8.50 by 11.00 inches

Orientation: s

Scale: 100 %

@ Cancel | [ OK ]

Printing on custom size paper ([Page Setup])
A special sized original is printed on custom sized paper loaded in the Manual Feed Tray.
In [Page Attributes] under [Paper Size:], select [Manage Custom Sizes...], and specify the desired width and
length.
From the [File] menu, click [Page Setup] (or [Paper Setup)).

= In Mac OS X 10.5 or later, you can configure the same setting in [Paper Size:] in the [Print] window.

Open the window for registering a custom size.

= In Mac OS X 10.4 or later, select [Manage Custom Sizes...] from the Paper Size list.
= In Mac OS X 10.3, select [Custom Paper Size] from [Settings:].

Click [+] (Mac OS X 10.4 or later) or [Add] (Mac OS X 10.3).

Enter the name of the paper size you are registering.

- Be sure to use paper size names other than existing names, such as A4 and Custom.

Specify the width and length as desired.

= If necessary, set the top, bottom, right, and left margins of the paper in [Non-Printable Area:] or
[Printer Margins:].

[T paper Size: 8.5 in 11in
Width Height
Non-Printable Area:

User Defined

25 in
25in UL 25in
Left 56in Right

Bottom

@) Cancel | [ OK |

Click [OK] (Mac OS X 10.4 or later) or [Save] (Mac OS X 10.3).

This saves the custom paper size, which can be selected from the [Paper Size:] drop-down list in [Page
Attributes].

@ Reference

To print on custom sized paper, use Manual Feed Tray. For details on how to load paper into the Manual
Feed Tray, refer to Chapter 6 in [User's Guide Introduction].
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Specifying the paper type ([Paper Type:])

In [Paper Type:] of the [Basic] menu for [Printer Features], select the paper type for printing.

Printer Features e
Feature Sets: | Basic
™ Collate
| | Nearest Size and Scale
|| Manually Print on 2nd Side

Paper Type: | Printer Default

Resolution: | 600dpi

Specifying the paper tray ([Paper Feed])
In [All Pages From:] of [Paper Feed], select the paper tray for printing.

Paper Feed _
@)AII Pages From: | Auto Select
(_)First Page From: Tray 1

Remaining From: Tray 1

Enlarging or reducing to the nearest page size ([Nearest Size and Scale])

If the size of sheets loaded in the paper tray does not match that of the original data, the page size is auto-
matically enlarged or reduced to be printed on sheets of the next nearest size.

Select [Printer Features] - [Basic], then select the [Nearest Size and Scale] check box.

Printer Features e
Feature Sets: | Basic
™ Collate
| | Nearest Size and Scale
|| Manually Print on 2nd Side

Paper Type: | Printer Default

Resolution: | 600dpi
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3.4.2 Printing multiple sets of copies

Specifying the number of copies ([Copies:])

In [Copies:] of the [Print] window, specify the number of copies you want to print.

Printer:

Presets: | Default Settings

Copies: |1

Pages: (=) All
(_JFrom: |1 to: |1

Tips
In Mac OS X 10.3/10.4, specify the number of copies in [Copies & Pages].

@ Reference

When you print a large number of copies, use of the Proof then Print function will prevent a large number of
misprints being created, reducing the amount of waste paper generated. For details, refer to page 3-26.

Printing on a set basis ([Collate])

When the [Collate] check box is selected on the [Basic] menu of [Printer Features], copies are output sepa-
rately in a set-by-set manner, for example, "Pages 1, 2, 3, 4, and 5", "Pages 1, 2, 3, 4, and 5", and then "Pages
1,2,3,4,and 5".

Printer Features >
Feature Sets: | Basic >
™ Collate
|_| Nearest Size and Scale
|| Manually Print on 2nd Side

Paper Type: | Printer Default

Resolution: | 600dpi s
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3.4.3 Saving the number of printed sheets

Copying on both sides of paper ([2-Sided])
By using both sides of paper for printing, you can halve paper consumption.

In [Print Type:] of the [Layout] menu for [Printer Features], select [2-Sided]. Also, in [Binding Position:], select
the binding position.

Printer Features e

Fearture Sets: | Layout

Print Type: | 2-Sided =l

Binding Position: | Left Bind =

Printing multiple pages on the same side of a single sheet
([Pages per Sheet:])

You can print multiple reduced size pages on the same side of a single sheet to reduce the number of pages
to be printed.

In [Pages per Sheet:] of [Layout], specify how many pages are to be printed on the same side of one sheet.
For example, when you select [9], every set of nine pages is reduced and printed on the same side of one
sheet.

If necessary, specify the paging order in [Layout Direction:], then select whether or not to insert a border line
between pages in [Border:].

Layout i

.

Pages per Sheet: | 4

Layout Direction: S '/l N

Border: | None T
Two-Sided: | Off

Reverse page orientation
Flip horizontally

Printing on the back side of printed sheet ([Manually Print on 2nd Side])

Select [Printer Features] - [Basic], then select the [Manually Print on 2nd Side] check box.

Printer Features O
Feature Sets: | Basic
™ Collate
|_| Nearest Size and Scale
|| Manually Print on 2nd Side

Paper Type: | Printer Default

Resolution: | 600dpi

Tips
When specifying [Manually Print on 2nd Side] for printing, use the back side of the sheet printed on this ma-
chine. The printing result with this setting is excluded from assurance.
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34.4 Adjusting the layout

Reversing the left and right sides ([Flip horizontally])
Reverse the left and right sides of a print image to make prints.

In [Layout], select the [Flip horizontally] check box.

Layout )

Pages per Sheet: | 1

= NIr"
Layout Direction X W} B

Border: | None
Two-Sided: | Off

Reverse page orientation
Flip horizontally

Tips
This function is available only for Mac OS X 10.6/10.7/10.8.

Rotating a print image 180 degrees ([Reverse page orientation])

Print an image upside down. This function is available when printing on envelopes of which the loading di-
rection cannot be changed.

In [Layout], select the [Reverse page orientation] check box.

— | Layout

Pages per Sheet: | 1

.
e = B

Layout Direction H 5 7 R

.

Border: | None
Two-Sided: | Off

Reverse page orientation
Flip horizontally

Tips
This function is available only for Mac OS X 10.5/10.6/10.7/10.8.
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3.4.5

Inserting a front cover

Inserting a front cover ([Paper Feed])
Insert a cover sheet that is different from text sheets into the head of the original.

You can select a sheet that is different from text sheets (colored paper or thick paper) as a front cover, and
collectively print the front cover with text pages.

In [First Page From:] of [Paper Feed], select the paper tray to load a sheet to be used as a front cover. Also,
in [Remaining From:], select the paper tray to load text sheets.

Paper Feed AN
(_JAll Pages From: | Auto Select
'E,"First Page From: | Tray 1

Remaining From: | Tray 1

Printing a message on a cover page ([Cover Page])
Print a message such as [Confidential] or [Secret] on a cover page.

In [Print Cover Page:] of [Cover Page], select whether or not to print a cover page at the head or end of the
document, then specify the type of the message to be printed in [Cover Page Type:].

To print billing information, enter the information to be printed in [Billing Info:].

Cover Page

Print Cover Page: (| None
'é,' Before document
(! After document

Cover Page Type: | Standard =

Billing Info:

3-20
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3.4.6 Specifying the color and image quality

Printing with gray scale ([Color as Grayscale])

In [Color Options], select the [Color as Grayscale] check box.

Color Options

Color Settings: Auto
Brightness: 0%
Color as Crayscale

Glossy Mode

Toner Save

Edge Strength: Middle

Advanced Color Options

Fine-tuning the brightness to fit the original ([Brightness:])
In [Brightness:] of [Color Options], fine-tune the brightness to fit the original.

Color Options

Color Settings: Auto
Brightness: 0%
Color as Grayscale
Glossy Mode

Toner Save

Edge Strength: Middle

Advanced Color Options

Specifying the printing resolution ([Resolution:])

In [Resolution:] of the [Basic] menu for [Printer Features], select the printing resolution.

Printer Features >
Feature Sets: | Basic >
™ Collate
|_| Nearest Size and Scale
|| Manually Print on 2nd Side

Paper Type: | Printer Default

Resolution: | 600dpi s
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Selecting the optimum color representation for the original
([Color Settings:])

Select the optimum settings for an original such as photos or presentation materials to print it at the optimum
image quality level.

In [Color Settings:] of [Color Options], select the optimum color setting mode for the original.

——— Color Options

Color Settings: Auto
Brightness: 0%
Color as Crayscale

Glossy Mode

Toner Save

Edge Strength: Middle

Advanced Color Options

If necessary, you can specify the color representation method for each object (image, text, or graphics) in an
original in detail.

1 In [Color Settings:] of [Color Options], select [Custom], then click [Advanced Color Options].

2 Specify RGB colors and output profile for printing on an image, text, or graphics category basis.

Settings Description

[Image] Configure a color setting for each image, text, or graphics category.
[Text] e [RGB Source:]: Specify the color space of the input RGB for the printer.
[Graphics] e [RGB Intent:]: Specify the property of color conversion from the input

RGB to Device CMYK that is processed by the printer.

e [RGB Gray Treatment:]: Specify the method to make prints in black or
gray for the printer.
[Destination Profile:]: Specify the output profile for the printer.
[Halftone:]: Specify the screen property for the printer.
[Edge Enhancement:]: Specify whether or not to enhance the edge

part.
[Simulation] Configure the simulation settings.
e [Simulation Profile]: Select the simulation profile of the input CMYK for
this machine.

e [Match Paper Color:]: Select whether or not to suit the background of
paper for printing when carrying out a simulation.

¢ [CMYK Gray Treatment:]: Specify the printing method of plate K in the
CMYK input data for simulation.

@ Reference

In [Manage Profile], you can add or delete various profiles. For details, refer to page 3-24.
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Making the image glossy ([Glossy Mode])
Images are printed with a glossy finish.

In [Color Options], select the [Glossy Mode] check box.

Color Options

Color Settings: Auto
Brightness: 0%
Color as Grayscale
Glossy Mode
Toner Save

Edge Strength: Middle

Advanced Color Options

Saving the toner consumption ([Toner Save])

Selecting the [Toner Save] check box in [Color Options] adjusts the printing density in order to reduce the

amount of toner consumed.

Color Options

Color Settings: Auto
Brightness: 0%
Color as Grayscale

Glossy Mode

Toner Save

Edge Strength: Middle

Advanced Color Options

Increasing the legibility of small or faint text ([Edge Strength:])
Sharpen the edges of images such as text in the table and graphics to improve legibility.

In [Edge Strength:] of [Color Options], select the strength level.

Color Options

Color Settings: Auto
Brightness: 0%
Color as Grayscale

Glossy Mode

Toner Save

Edge Strength: Middle

Advanced Color Options

d-Color MF 3300/3800
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3.4.7 Using a color profile

Registering a color profile on this machine

Save a color profile on the HDD of this machine using Download Manager.

v

H WO N = N

()]

6
7

Before starting this procedure, newly create a "Download Manager (model name)" folder in the appli-
cation folder of the computer, then copy the Download Manager program to the created folder. The
Download Manager program can be downloaded from the utility software download page that is dis-
played by selecting [Utility Software] in the Drivers & Utilities CD/DVD-ROM menu.

For details on how to use Download Manager, refer to the Download Manager Help.
Start Download Manager.

Select [Color Profile], then specify this machine in [Choose Printer:].

Select [Download], then select [Disk] as a download destination.

Click [Browse], then specify the color profile you want to download to the HDD of this machine.

- Set the color profile name to the format "file name = ASCII (up to eight characters) + extension ASCII
(up to three characters)".

Click [Download Profile].
Click [OK].

Click [Exit].

Adding a color profile to the printer driver

Add the color profiles saved on the HDD of this machine to the printer driver.

v

v

This function is available if the computer can communicate with this machine. The computer commu-
nicates with this machine and loads color profiles that the machine can use.

For details on how to register a color profile on the HDD of this machine, refer to page 3-24.
In [Color Settings:] of [Color Options], select [Custom], then click [Advanced Color Options].

Click [Manage Profile].

Color Options

Text = Graphics Simulation |

RGB Source: | sRGB ol
RGE Intent: | Photographic =
RGB Gray Treatment: | Black and Gray Sl
Destination Profile: | Auto =
Halftone: | Detail ol
Edge Enhancement: | off =

Manage Profile

Hide Advanced Options
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3 In Driver Profile List, select the type of the color profile to be added to the printer driver.

Driver Profile List: | RGB Color + |
['In Menu File Name Profile Name Location | Add |
Edit

Delete

File Name: Browse

Profile Name:

Location: | Disk

Cance oK

| cancel | | ok |

4 Select the color profile to be added, then click [Add].

5  Click [OK].

The color profile is added to Driver Profile List.

After this, you can specify the color profile added here on the [Advanced Color Options] window to carry

out printing. For details, refer to page 3-22.
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3.5 Printing options

3.5.1 Making a trial printing for only one copy ([Proof then Print])

Proof then Print

Proof then Print is a function that makes prints by only one copy and holds the remaining copies when print-
ing multiple copies.

Because you can check the print result before starting to print the remaining copies from the Control Panel,
this function is useful for preventing printing of a large number of misprints.

How to print from the computer

In [Job Retention:] of the [Security] window, select [Proof then Print].

Security

Job Retention: Proof then Print

User Authentication Account Track

* ) Public User
Recipient User

Specify the number of copies, then execute printing.

Only one copy is printed. Continue to "Operations on this machine".
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Operations on this machine

1 Tap [Document Print/Delete].

Select function.

Job List Counter

C Q Scan To @ Scan To @ F
opPY E-mail Folder ax

= &
Document Utilit
Print / Delete ity

2 Tap [Documents to Print].

Select desired function.

% &
Documents to Print ID & Print E"I“e"“"
lemory

%

Scanned
Documents

3 Select the desired user, then tap [Open].

4 Selecta job to print, then tap [Print].
= To delete a job, tap [Delete].

5 necessary, change the number of copies, then tap [OK].

d-Color MF 3300/3800
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3.5.2 Printing a highly confidential original ([Secured Job])

Secured Job

Secured Job is a function that saves print data with a password on the HDD of this machine. Because the
data is not printed straight away, this function prevents printed materials from going missing or being left un-
attended.

To print data from the HDD, you need to enter the password; this function is particularly suitable for safely
printing highly confidential documents.

How to print from the computer
1 In [Job Retention:] of the [Security] window, select [Secured Job].

Security

Job Retention: Secured Job

Security Print Settings

Password:

User Authentication Account Track

* ) Public User
Recipient User

2 Enterthe password.

3 Execute printing.

Print data is saved on the HDD of this machine. Continue to "Operations on this machine".
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Operations on this machine

To print the saved data, you need to enter the password specified in the printer driver.

1 Tap [Document Print/Delete].

Select function.

Job List Counter

Cor Q Scan To @ Scan To @ Fax
H E-mail Folder

¥
Document & Utilit -
Print / Delete Y

2 Tap [Documents to Print].

Select desired function.

s &

Documents to Print ID & Print

%

Scanned
Documents

External
Memory

3 Select the desired user, then tap [Open].

4 Selecta job to print, then tap [Print].

= To delete a job, tap [Delete].
5  Enterthe password specified when printing data from the computer.

6 i necessary, change the number of copies, then tap [OK].
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3.5.3

Attaching authentication information

Printing when authentication is set

When printing a document in an environment where user authentication or account track is employed, you
need to send the authentication information (user name and password) to this machine to execute printing.
This requirement limits the users who can use this machine, preventing unauthorized use by a third party.

When this machine receives a print job from a user who is not permitted to print, or a print job that does not
contain authentication information, this machine automatically discards the job.

Tips

° A print job that does not contain authentication information is a print job that is sent without correctly
configuring the User Authentication/Account Track setting using the printer driver even though the User
Authentication/Account Track setting is configured on this machine.
If [Print] in [Job Retention:] is selected to execute a print job while the [User Authentication]/[Account
Track] check box is cleared in the [Security] window of the printer driver, the print job is considered as
a print job that does not contain authentication information.

) If [ID & Print] is set to [Enable] on [Security] - [ID & Print Settings] of Web Connection, an ordinary print
job is handled as an ID & Print job (default: [Disable]). For details on the ID & Print function, refer to
page 3-31.

@ Reference

When printing a highly confidential document in an environment where user authentication or account track
is employed, using the ID & Print function enables high security printing. For details, refer to page 3-31.

How to print from the computer

In the [Security] window, select the [User Authentication] check box (and the [Account Track] check
box).

Security =

Job Retention: Print =

@User Authentication @A((uunt Track
() Public User Department Name:
(=) Recipient User
User Name:

Password:

Password:

When user authentication is enabled, select the [User Authentication] check box, select [Recipient Us-
er], then enter the user name and password.

= If access to this machine by public users (unregistered users) is allowed, you can select [Public User]
and print data without entering the user name and password.

When account track is enabled, select the [Account Track] check box, enter the account name and
password, then click [OK].

Execute printing.

Printing starts successfully when the authentication information is judged correct.
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3.5.4 Printing at the same time as authentication ([ID & Print])

ID & Print

ID & Print is a function that saves print data to the HDD of this machine when user authentication is installed.
Because the data is not printed straight away, this function prevents printed materials from going missing or
being left unattended.

To print data from the HDD, you need to perform user authentication on this machine; this function is par-
ticularly suitable for safely printing highly confidential documents. When you are successfully authenticated,
the print data of the login user is automatically printed. This enhances security as well as ensures smooth
operation.

@ Reference

User Authentication/Account Track can only be configured using Web Connection. For details, refer to Chap-
ter 1 in [User's Guide Applied Functions].

To enable the ID & Print function, select [Security] - [ID & Print Settings] in the Web Connection administrator
mode, then set [ID & Print] to [Enable]. For details, refer to Chapter 1 in [User's Guide Applied Functions].

How to print from the computer

In [Job Retention:], select [ID & Print].

Security

Job Retention: ID&Print

@User Authentication E]Account Track
() Public User Department Name:
() Recipient User
User Name:

Password:

Password:

Select the [User Authentication], select [Recipient User], then enter the user name and password.

Execute printing.

Print data is saved on the HDD of this machine. Continue to "Operations on this machine".
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Operations on this machine (Printing simultaneously with login)

Print all data saved by the ID & Print function simultaneously when performing authentication on this machine.

1
2

Operations on this machine (Printing only specific data)

To print only specific data, log in to this machine, then specify data to be printed.

1

2

Enter the user name and password.

Check that [ID & Print/MFP Access] is selected in [ID & Print], then tap [Login].

- When an optional Authentication Unit is used, you can switch [Device Authentication] and [Authen-

tication Unit] in [Authentication Method].

Enter User Name and Password, 2013/06/14 16:20

and touch Login or Access. n:ﬁ
K

Authentication Method ID & Print

ID & Print/MFP Access ] Public
User
Access
Basic Screen I
g

I =)

User Name

Password

Server

A

If authentication succeeds, all the saved data is printed.
- After data has been printed, do not log in to the machine.

- To change the default settings of [ID & Print] (default: [ID & Print/MFP Access]), select [Security] -
[ID & Print Settings] - [Default Operation Selection] in the Web Connection administrator mode.

Enter the user name and password.
In [ID & Print], select [Access Basic Screen], then tap [Login].

Enter User Name and Password, 2013/06/14 16:20
-

and touch Login or Access. "E'
K

Authentication Method ID & Print

ID & Print/MFP Access I Public
User
Access
Basic Screen I
g

I =)

User Name

Password

Server

A
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3 Tap [Document Print/Delete].

Select function.

Job List

C Q Scan To @ Scan To @ F
opPY E-mail Folder ax

Document
Print / Delete

4 Tap[ID &Print].

Counter

&

Select desired function.

.

Documents to Print ID & Print

&

External
Memory

Scanned
Documents

5 Tap [Login User].

Select user.

Public User

+ ) E

Login User ‘

6 Select data to be printed, then tap [Print].

= To delete data, tap [Delete].
The printed data is deleted from the HDD.
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3.6 Printer driver setting items

3.6.1 [Page Setup] window of the printer driver

How to display the [Page Setup] window

Open the original data using the application software. From the [File] menu, click [Page Setup] (or [Pa-
per Setup]).

Check that the desired printer is selected in [Format for:].

The [Page Attributes] window appears.

Settings: | Page Attributes

Format For: | Printer Name
= PPD
Paper Size: | Letter
8.50 by 11.00 inches

Orientation: Ts

Scale: |100 %

7 Cancel | [ OK |

Available operations in [Page Attributes]

In [Page Attributes], you can configure basic paper settings.

Settings Description

[Paper Size:] Select the size of paper for printing.
To print on custom sized paper, use [Manage Custom Sizes...]. For details, re-
fer to page 3-15.

[Orientation:] Specify the orientation of the original created in application software.
If the setting in the printer driver differs from the one specified in the application
software, correct the setting.

[Scale:] Specify the zoom ratio to enlarge or reduce the original image. The setting
range differs depending on the Mac OS X version.

Tips
In Mac OS X 10.5 or later, you can also specify [Print] and [Orientation] in the [Paper Size] window.
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3.6.2 [Print] window of the printer driver

How to display the [Print] window
1 Open data of the original using the application software. From the [File] menu, select [Print].

2 Check that the desired printer is selected in [Printer:].

Printer: | Printer Name

Presets: | Default Settings

Copies: |1
Pages: (=) All
From: |1 to: |1
(_)Selected Page in Sidebar
Paper Size: | 8 1/2x11 +| 850 by 11.00 inches

Orientation: To

Preview £

™ Auto Rotate Show Notes

M4 | 4 | 25001250 [ b | bbi Scale: 91%

() Scale to Fit: (&) Print Entire Image
“JFill Entire Paper

Copies per page: 1

(7)) [ PDF *| | Hide Details Cancel | [ Print |

Items common to each window

This section describes the settings and buttons common to the [Print] window.

Settings Description
[Copies:] When printing multiple sets of copies, specify the number of sets.
[Collated] Do not specify this function.
In the [Basic] menu of [Printer Features], select the [Collate] checkbox.

[Pages:] When printing a multi-page original, specify the range of pages to be printed.
[Paper Size:] Specify the size of the paper to be printed.
[Orientation:] Specify the printing orientation.
[Cancel] Discards (or cancels) the current changes and closes the setting window.
[Print] Applies the changes made to the settings and starts printing.

Tips

° [Copies:], [Pages:], [Paper Size:], and [Orientation:] are displayed in Mac OS X 10.5 or later.
° In Mac OS X 10.7/10.8, [Collated] is not displayed.
° In Mac OS X 10.3/10.4, [Copies:] and [Pages:] can be specified in [Copies & Pages].
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3.6.3 Available operations in [Layout]

In [Layout], you can configure layout settings for printing.

Settings Description

[Pages per Sheet:] Select how many pages are to be printed on the same side of one sheet.
For example, when you select [9], every set of nine pages is reduced and print-
ed on the same side of one sheet.

[Layout Direction:] Select the paging order when [Pages per Sheet:] is specified.

[Border:] Select whether or not to insert a border line between pages when [Pages per
Sheet:] is specified. If you want to insert a border line between pages, select
the border line type.

[Two-Sided] Do not specify this function.
In [Print Type:] of the [Layout] menu for [Printer Features], select this function.

[Reverse page orienta- Select this check box to rotate a print image 180 degrees.
tion]

[Flip horizontally] Select this check box to reverse the left and right sides of a print image.

3.6.4 Available operations in [Scheduler]

In [Scheduler] you can specify the print starting timing or priority sequence.

Settings Description

[Print Document:] Specify the timing to start printing.

e [Now]: Starts printing immediately.

e [At]: Starts printing at the specified time.

e [On Hold]: Holds print jobs in the computer. Printing can be started from
the job screen of the printer.

[Priority:] Specify the priority level of each print job.

Tips
This function is available only for Mac OS X 10.3/10.4/10.5/10.6.

3.6.5 Available operations in [Paper Handling]

In [Paper Handling], you can specify pages to be printed or their order.

Settings Description
[Collated] Do not specify this function.
In the [Basic] menu of [Printer Features], specify the value in [Collate].
[Pages To Print:] Specify the pages to be printed from All, Odd, and Even.
[Page Order:] Specify the order of pages to be printed.

¢ [Automatic]: Automatically judges the order of pages to be printed.
e [Normal]: Prints pages in sequence from the first.
¢ [Reverse]: Prints pages in sequence from the last.

[Destination Paper Specify the size of the paper to be printed.
Sizel] e [Scale to fit paper size]: Prints data on sheets of the specified size.
e [Scale down only]: Prints data only on sheets to be reduced.

Tips
[Collated] is displayed only in Mac OS X 10.7/10.8.
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3.6.6 Available operations in [ColorSync]
In [ColorSync], you can specify the color conversion method or Quartz filter.
Settings Description
[Color Conversion:] Select the color conversion method.
e [Standard]: Performs color conversion using the computer.
e [In Printer]: Performs color conversion using the printer.
[Quartz Filter:] Specify the Quariz filter to be applied.
Tips
This function is available only for Mac OS X 10.3/10.4.
3.6.7 Available operations in [Color Matching]
In [Color Matching], you can specify the color conversion method or a color profile.
Settings Description
[ColorSync] / [In Printer] | Select the color conversion method.
e [ColorSync]: Performs color conversion using the computer.
e [In Printer]: Performs color conversion using the printer.
[Profile:] Specify the color profile to be used for color conversion.
Tips
This function is available only for Mac OS X 10.5 or later.
3.6.8 Available operations in [Cover Page]
In [Cover Page], you can configure settings to print a cover page.
Settings Description
[Print Cover Page:] Select whether or not to print a cover page at the head or end of a document.
[Cover Page Type:] Select the type of a message to be printed on a cover page.
[Billing Info] Enter billing information when printing it on a cover page.
3.6.9 Available operations in [Error Handling]

In [Error Handling], you can specify processing when an error has occurred during PS printing.

Settings

Description

[PostScript Errors]

Select whether or not to output a report when an error has occurred during PS
printing.

[Tray Switching]

Tips

This function is not used in this printer driver.

This function is available only for Mac OS X 10.3/10.4.
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3.6.10

3.6.11

3.6.12

Available operations in [Paper Feed]

In [Paper Feed], you can specify the paper tray for printing.

Settings

Description

[All Pages From:]

Specify the paper tray for printing.

[First Page From:]

Specify the paper tray to load sheets for printing the first page. Also, in [Re-
maining From:], specify the paper tray for printing the remaining pages.

Available operations in [Color Options]

In [Color Options], you can configure settings for the image quality of the original. You can specify colors and

image processing.

Settings Description
[Color Settings:] Select the optimum color setting mode for the original.
¢ [Auto]: The color setting suitable for originals is applied automatically.
e [Photo]: The color setting that prioritizes the image quality is applied.
e [Presentation]: The color setting suitable for originals containing both text
and figures is applied.
¢ [Custom]: Manually configure the color setting for each object (image, text,
or graphics) in the original. Selecting [Custom] enables [Advanced Color
Options].
[Brightness:] Adjust the brightness to fit the original.

[Color as Grayscale]

Select whether or not to print in color or gray scale.

[Glossy Mode]

Select this check box to print images with a glossy finish.

[Toner Save]

Select this check box to save the amount of toner consumed. The printing den-
sity is reduced.

[Edge Strength:]

Select this check box to enhance image edges when you want to sharpen
small or faint characters.

[Advanced Color Op-

tions]

For each element of the document, specify in detail the type of the color profile
used for printing and other profiles to be applied. For details, refer to
page 3-22.

Available operations in [Security]

In [Security], you can configure print settings.

Settings Description
[Job Retention:] Select the method to use to print the original from this machine.
[Print] Select this option to print normally.
[Secured Job] Select this option to print highly confidential documents. Printing is allowed

when the ID and password are entered on this machine.
For details, refer to page 3-28.

[Proof then Print]

Select this option to print a large number of copies. This machine prints only one
copy and waits for the user's command before printing the remaining copies.
For details, refer to page 3-26.

[ID & Print]

Select this option to print highly confidential documents in an environment
where user authentication is employed. Printing is allowed when the user is au-
thenticated to use this machine.

For details, refer to page 3-31.

[Security Print Settings]

Enter the password when [Secured Job] is selected in [Job Retention:].

[User Authentication]

When user authentication is employed, select this check box, then enter the
user name and password.

[Account Track]

When account track is employed, select this check box, then enter the account
name and password.
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Printer driver setting items

3.6.13 Available operations in [Printer Features]

3.6.14

3.6.15

Configure the basic print settings on the [Basic] menu.

Settings

Description

[Collate]

When printing multiple sets of copies, select this check box to output sets of
copies one by one.

[Nearest Size and
Scale]

Select whether or not to automatically enlarge or reduce the page size and
print data on sheets of the next nearest size when the size of sheets loaded in
the paper tray does not match that of the original data.

[Manually Print on 2nd

Select whether or not to print data on the back side of a sheet that has been

Side] printed on once.
To apply this function, use the back side of the sheet that was printed on this
machine. The printing result with this setting is excluded from assurance.
[Paper Type:] Select the type of sheets to be printed.

[Resolution:]

Select the print resolution.

In the [Layout] menu, you can configure layout settings for printing.

Settings

Description

[Print Type]

Select whether or not to print data on both sides of paper.

[Binding Position:]

When you have selected [2-Sided] in [Print Type:], select the binding position
of paper.

Available operations in [Supply Levels]

In [Supply Levels], you can check the status of consumables.

Tips

° This function is displayed when a Bonjour connection, IPP connection, or LPD connection is estab-
lished in Mac OS X 10.4 or later.

° This function may not be displayed depending on your application software.

Available operations in [Summary]

In [Summary], you can check the current print settings.

Tips

This function is displayed only in Mac OS X 10.3/10.4/10.5/10.6.
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Uninstalling the printer driver

When you have to remove the printer driver, for example, when re-installation of the printer driver is neces-
sary, uninstall the driver using the following procedure.

1

In [System Preferences...] of the Apple menu, open the [Print & Fax] or [Print & Scan] window.

= In Mac OS X 10.3/10.4, select [Macintosh HD] - [Applications] - [Utilities], then open the [Printer Set-
up Utility] window.

Select the printer you want to delete, then click [-] (or [Delete]).

The selected printer is deleted.

Close the [Print & Fax] or [Print & Scan] window.

Select [Macintosh HD] (hard disk of the system) in which you installed the printer driver, then select [Li-

brary] - [Printers] - [PPDs] - [Contents] - [Resources] ([Resources] in Mac OS X 10.5 or later, each lan-

guage folder in [Resources] in Mac OS X 10.3/10.4). Then, drag the gz file of this machine to [Trash].

Delete unnecessary files from [Library] - [Printers].
= Open [Library] - [Printers] - [GENERIC], then drag the folder of this machine to [Trash)].

In Mac OS X 10.3/10.4/10.5, open [Library] - [Recipients], then drag the pkg file of this machine to
[Trash].

Restart the computer.

Uninstallation of the printer driver is then completed.
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4.1 Directly printing from the computer (Direct Print) 4

N0
4 Printing without Using the Printer Driver
4.1 Directly printing from the computer (Direct Print)

Direct Print

Direct Print is a function that directly sends files on your computer to this machine to print them without using
the printer driver. You can print a file stored on your computer by specifying it using Web Connection.

This function is available for file types PDF, Compact PDF, JPEG, TIFF, XPS, Compact XPS, Open XPS,
OOXML (.docx/.xIsx/.pptx), and PPML (.ppml/.vdx/.zip).

Tips
° However, the encrypted PDF file cannot be printed.

° Application software programs that offer the same function as Direct Print of Web Connection through
simpler operations include Direct Print. Features such as printing through drag-and-drop to the desk-
top icon, printing using the [Send To] menu in Windows, and automatic printing using a hot folder (print
monitoring folder) are available. You can also register multiple job settings in which print settings are
configured. Direct Print can be downloaded from the utility software download page that is displayed
by selecting [Utility Software] in the Drivers & Utilities CD/DVD-ROM menu. For details, refer to the
Direct Print manual.

How to use Direct Print

Connect to Web Connection using a Web browser, then specify the file you want to print.

Access to the Web Connection using the Web browser.

= Enter the IP address of this machine in the URL field of the Web browser, then press the Enter key
on the keyboard.
http://<IP address of this machine>/

Log in with the account of a public user or registered user.
In the [Print] tab, click [Direct Print].

Click [Browse] to select a file to print, then click [Send].

The file is sent and printed.

@ Related setting
° You can configure print settings to directly print the OOXML (.docx/.xIsx/.pptx) file.
To configure settings: [Utility] - [User Settings] - [Printer Settings] - [OOXML Print Settings]
° You can specify the method for determining the paper size when directly printing TIFF, JPEG, or PDF
files.
To configure settings: [Utility] - [User Settings] - [Printer Settings] - [Paper Setting] - [TIFF Image Paper
Setting] (default: [Priority Paper Size))
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Printing directly from a USB memory device

Printing from a USB memory device

By connecting a USB memory device to this machine and specifying a file stored in the USB memory device,
you can print the file.

This function is available for file types PDF, Compact PDF, JPEG, TIFF, XPS, Compact XPS, Open XPS,
OOXML (.docx/.xIsx/.pptx), and PPML (.ppml/.vdx/.zip).

Tips

However, the encrypted PDF file cannot be printed.

@Related setting (for the administrator)
You can specify whether to enable or disable printing data from USB memory.
To configure settings: [Utility] - [Administrator Settings] - [System Settings] - [Folder Settings] - [External
Memory Function Settings] - [Print Document] (default: [ON]).

Supported USB memory devices

USB memory devices that have the following specifications can be connected to this machine.

Item Specifications
Supported media USB memory device (USB 2.0 supported)
File system FAT32

Tips

Note the following points when connecting a USB memory device to this machine.

Use the USB connector on the side that is near the Control Panel.

Do not disconnect the USB memory device while saving a file to the USB memory or printing a file in
the USB memory.

Use only a USB memory device on this machine. Do not use other USB devices (such as a hard disk
unit or USB switching hub).

Do not connect or disconnect the USB memory device when the hourglass is displayed in the Control
Panel while this machine is active.

Do not disconnect the USB memory device directly after connecting it.
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Printing procedure
1 Connect a USB memory device to the USB port of this machine.

2 Tap [Document Print/Delete].

Select function.

Job List Counter

Cor Q Scan To @ Scan To @ Fax
H E-mail Folder

25¥
Document & Utilit -
Print / Delete Y

3 Tap [External Memory].

Select desired function.

s &

Documents to Print ID & Print External

Memory

| |

Scanned
Documents

4 Selectafileto print, then tap [Print].

= Tap [Up] to move upward.
= Tap [Open] to open the folder and move downward.

5 i necessary, change print settings, then tap [Print].

Settings Description

[Paper Size] Select the size of paper for printing. This can be specified when the select-
ed file type is TIFF or JPEG.

[Duplex] Select whether or not to print data on one side or both sides of sheets of

paper. To print data on both sides, select the binding position.

[Finishing] - [Collate] When printing data by multiple copies, select whether or not to feed out
copies separately one by one like "12345", "12345", and "12345".

@ Related setting
° You can configure print settings to directly print the OOXML (.docx/.xIsx/.pptx) file.
To configure settings: [Utility] - [User Settings] - [Printer Settings] - [OOXML Print Settings]

° You can specify the method for determining the paper size when directly printing TIFF, JPEG, or PDF
files.
To configure settings: [Utility] - [User Settings] - [Printer Settings] - [Paper Setting] - [TIFF Image Paper
Setting] (default: [Priority Paper Size])
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